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About this document
This document is a global document. Contact your system supplier or your 
Nortel representative to verify that the hardware and software described are 
supported in your area.

Subject
This document contains information about Attendant PC Software. It 
describes software features, installation and configuration, use, 
administration, and installation of the Attendant PC LAN Interface.

Note on legacy products and releases

This NTP contains information about systems, components, and features that 
are compatible with Nortel Communication Server 1000 Release 4.5 
software. For more information on legacy products and releases, click the 
Technical Documentation link under Support & Training on the Nortel 
home page:

http://www.nortel.com

Applicable systems
This document applies to the following systems:

• Communication Server 1000S (CS 1000S)

• Communication Server 1000M Chassis (CS 1000M Chassis)

• Communication Server 1000M Cabinet (CS 1000M Cabinet)

• Communication Server 1000M Half Group (CS 1000M HG)

• Communication Server 1000M Single Group (CS 1000M SG)

http://www.avaya.com/
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• Communication Server 1000M Multi Group (CS 1000M MG)

• Communication Server 1000E (CS 1000E)

• Meridian 1 PBX 11C Chassis 

• Meridian 1 PBX 11C Cabinet

• Meridian 1 PBX 51C

• Meridian 1 PBX 61C

• Meridian 1 PBX 81

• Meridian 1 PBX 81C

Note: When upgrading software, memory upgrades may be required on 
the Signaling Server, the Call Server, or both.

System migration 

When particular Meridian 1 systems are upgraded to run CS 1000 
Release 4.5 software and configured to include a Signaling Server, they 
become CS 1000M systems. Table 1 lists each Meridian 1 system that 
supports an upgrade path to a CS 1000M system.

Table 1
Meridian 1 systems to CS 1000M systems

This Meridian 1 system... Maps to this CS 1000M system

Meridian 1 PBX 11C Chassis CS 1000M Chassis

Meridian 1 PBX 11C Cabinet CS 1000M Cabinet

Meridian 1 PBX 51C CS 1000M Half Group

Meridian 1 PBX 61C CS 1000M Single Group

Meridian 1 PBX 81 CS 1000M Multi Group

Meridian 1 PBX 81C CS 1000M Multi Group
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For more information, see one or more of the following NTPs:

• Communication Server 1000M and Meridian 1: Small System Upgrade 
Procedures (553-3011-258)

• Communication Server 1000M and Meridian 1: Large System Upgrade 
Procedures (553-3021-258)

• Communication Server 1000S: Upgrade Procedures (553-3031-258)

• Communication Server 1000E: Upgrade Procedures (553-3041-258)

Intended audience
This document is intended for individuals responsible for installing, 
configuring, administering and using Attendant PC Software and the 
Attendant PC LAN Interface.

Conventions

Terminology

In this document, the following systems are referred to generically as 
“system”:

• Communication Server 1000S (CS 1000S)

• Communication Server 1000M (CS 1000M)

• Communication Server 1000E (CS 1000E)

• Meridian 1

The following systems are referred to generically as “Small System”:

• Communication Server 1000M Chassis (CS 1000M Chassis)

• Communication Server 1000M Cabinet (CS 1000M Cabinet)

• Meridian 1 PBX 11C Chassis

• Meridian 1 PBX 11C Cabinet

The following systems are referred to generically as “Large System”:

• Communication Server 1000M Half Group (CS 1000M HG)
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• Communication Server 1000M Single Group (CS 1000M SG)

• Communication Server 1000M Multi Group (CS 1000M MG)

• Meridian 1 PBX 51C

• Meridian 1 PBX 61C

• Meridian 1 PBX 81

• Meridian 1 PBX 81C

Related information
This section lists information sources that relate to this document.

NTPs

The following NTPs are referenced in this document:

• Features and Services (553-3001-306)

• Software Input/Output: Administration (553-3001-311)

Online

To access Nortel documentation online, click the Technical Documentation 
link under Support & Training on the Nortel home page:

www.nortel.com

CD-ROM

To obtain Nortel documentation on CD-ROM, contact your Nortel customer 
representative.

How to get Help

Getting Help from the Nortel Web site

The best source of support for Nortel products is the Nortel Support Web site:

www.nortel.com/support

http://www.avaya.com/
http://support.avaya.com
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This site enables customers to:

• download software and related tools

• download technical documents, release notes, and product bulletins

• sign up for automatic notification of new software and documentation

• search the Support Web site and Nortel Knowledge Base

• open and manage technical support cases

Getting Help over the phone from a Nortel Solutions Center

If you have a Nortel support contract and cannot find the information you 
require on the Nortel Support Web site, you can get help over the phone from 
a Nortel Solutions Center. 

In North America, call 1-800-4NORTEL (1-800-466-7865).

Outside North America, go to the Web site below and look up the phone 
number that applies in your region:

www.nortel.com/callus

When you speak to the phone agent, you can reference an Express Routing 
Code (ERC) to more quickly route your call to the appropriate 
support specialist.  To locate the ERC for your product or service, go to:

www.nortel.com/erc

Getting Help through a Nortel distributor or reseller 

If you purchased a service contract for your Nortel product from a distributor 
or authorized reseller, you can contact the technical support staff for that 
distributor or reseller.

http://www.avaya.com/gcm/master-usa/en-us/tasks/connect/contacts/sales/salescontact.htm
http://support.avaya.com/supportfaqs
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Overview

Contents
This section contains information on the following topics:

Description  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

About the Attendant PC  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
Starting the Attendant PC. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
Menus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
Two-line display. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
Position Busy indicator. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
Fixed keys. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
Loop keys . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
Incoming Call Indicator Keys  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
Trunk Group Busy keys . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

Placing a call . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

Using the Attendant PC online help . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
Using the Help Index feature . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
Exploring the Help Console . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

Description

 The Attendant PC software allows you to perform attendant console and call 
processing functions on a computer workstation using a mouse pointing 
device or keyboard within a Windows 95®, Windows 98®, Windows 2000®, 
Windows NT®, or Windows XP® operating system environment. 
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About the Attendant PC
This section describes how to set up the Tools menu, configure features, use 
the Attendant PC Help facility, do common call processing tasks and points 
you to the other features that come with the Attendant PC software.

You can access the console functions by using the mouse to activate:

• Loop keys

• Incoming Call Indicator (ICI) keys

• Trunk Group Busy (TGB) keys

• Fixed keys (Release, Hold, Answer, Rls Dst, CAS)

• Flexible feature keys

• Virtual feature keys

• Hotkeys

Starting the Attendant PC

When your Attendant PC software is installed and a shortcut is created on 
your workstation desktop, simply double-click the icon Shortcut to 
console.exe to launch Attendant PC.

Figure 1on page 29 displays the Attendant PC main screen.
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Figure 1 
Attendant PC console display

You can resize and position the Attendant PC main screen and tool 
windows any way you like by using the mouse to:

• Move - Left click the mouse on the top part of the console or window and 
drag it to the desired location.

• Resize - Move the cursor over any console or tools window edge until it 
changes to a , then left click and drag to resize the window. 

Fixed keys
Loop keys

Status Indicator

Loop Keys

Mini-keypad

Directory 

Two-line display

Dialpad
Numbers

Program Menus

Position
Busy Button
and Lamp
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Menus

The Attendant PC menus located in the upper left corner provide access to 
many Attendant PC features. Each submenu that follows introduces you to 
one of the following four menus:

— Tools — Console — Config — Help

Two-line display

There is a two-line display just above the Position Busy and Attendant PC 
indicators. The first line displays information about the source of a call. The 
second line displays information about the extended call. Figure 2 shows the 
two-line display.

Figure 2: Two-line display

Position Busy indicator

Just above the keypad is a Position Busy indicator. Use this key to prevent 
calls from being routed to your console. When you first launch the Attendant 
PC, the Position Busy lamp is on. When all Attendant PC workstations are in 
Position Busy, the system is automatically put into Night mode. In Night 
mode, all incoming calls are routed to a destination other than the Attendant 
PC. For example, incoming calls can be routed to a recorded message.

Help

Tools Console

Config

Source of call

Destination of call, trunk o
access codes

Status Indicator
lamp

Position Busy
button

Centralized Attendant
Service button

Release Destination
button
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Fixed keys

The Attendant PC fixed keys are described below:

• Click your mouse on Answer to connect to the current incoming caller

• Click on Hold to put the current caller on hold so you can answer another 
call or perform transferring or conferencing services

• Click on the Release key to disconnect the current calling party.

• Click Rls Dst to release a called party, unanswered ringing, busy signal 
or an extension requesting a transfer.

• Click CAS to automatically reroute calls to a centralized attendant at the 
main location.

Loop keys

Loop keys allow the attendant to answer and originate calls from the 
Attendant PC.

There are six loop keys, numbered from 0 to 5. There are two half-diamonds 
next to each pickup key to indicate each loop’s status for:

• Source: the half-diamond on the left gives status at the call’s source

• Destination: the half-diamond on the right displays status at the call’s 
destination

In either case, the half-diamond may be off, flashing, or steady on:

• Off: no activity is occurring on the line whose half-diamond is off

• Flashing: the caller is waiting to be connected, or their line is on hold

• Steady on: the caller is connected to another party

• Steady red: the caller is busy

Incoming Call Indicator Keys

Incoming call indicators (ICI) indicate the type of call coming to your 
console. The ICI keys help the attendant to: 

• identify the type of incoming calls queued

Source

Destination
Lamp

ICI key
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• prioritize call answering

• verify how many calls are in queue

• determine how long calls have been waiting

To answer a call associated with an ICI key, click on the flashing ICI lamp in 
the ICI List.

Trunk Group Busy keys

Trunk Group Busy Keys (TGB) enable you to deny users access to trunk 
groups and have calls to those trunk groups sent to your console instead. The 
lamps show the status of each group of trunks. You can create up to 20 trunk 
group busy (TGB) keys that deny users access to one or more trunk groups 
from 0 to 9. Refer to “The TGB tab” on page 94 for a detailed description of 
TGB keys.The following indications display the status for each trunk group:

• Steady on: you busied out all trunks in the group by pressing the TGB 
key.

• Off: With the TGB lamp steadily lit, press the TGB key to turn the 
indicator off and permit access to the trunk group.

• Flashing: All trunks in the group are busy.

TGB key
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Placing a call
The Attendant PC supports four methods to dial in-house or outside:

• Use your mouse to click on the dialpad numbers shown on the screen 

• Use the numeric keypad on your PC’s keyboard

• Drag and drop a highlighted telephone number into the mini-keypad near 
the top left corner of the console display

• Drag and drop highlighted text into the Directory icon near the top of the 
console display

For more information on call processing and feature activation, refer to 
“Attendant PC call processing” on page 105.

Using the Attendant PC online help
The onscreen Help provides information on using Attendant PC features, 
configuring the PC console, and reference sections which contains additional 
information such as a Glossary and Troubleshooting. 

Figure 3 on page 34 shows the Attendant PC Help Topics window.

Mini-keypad

Directory

Dialpad numbers

Help Menu
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Figure 3
Attendant PC Help Topics 

This section includes many references to Help. Many sections in the manual 
contain a table like the one shown below that lists Help keywords for you to 
search on in the Help index. This way, we can provide the details when you 
need them and where you need them: while you are administering to the 
typical operation of the Attendant PC.

For more information on using Attendant PC online help, refer to “Using the 
Attendant PC Help Facility” on page 183.

Using the Help Index feature

To locate information quickly, choose Index from the Help menu. Figure 4 
on page 35 shows the Attendant PC Help Index.

To learn about... Search the Help Index for...

adding a new operator new operator

adjusting the sound volume volume
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Figure 4
Attendant PC Help Index 

Exploring the Help Console

To locate comprehensive console information, use either the Help Contents, 
Find, and or Glossary functions. Figure 5 shows the Help Console window.

Figure 5
Help Console window

Click on Glossary for a list 
of console terms.
Click Help Topics to 
display the Help Contents, 
Index, and Find tabs.
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Working with the Tools menu

Contents
This section contains information on the following topics:

Tools menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

Feature List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
Fixed features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
Flexible features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
Virtual features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

ICI List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Adding an ICI key  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
Adding an ICI key  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
Using the ICI Keys page. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48

TGB keys. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49

Building a ToolBox. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

Accessing the CPLUS Directory. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

Directory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
Starting the Directory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54
Creating a Directory entry  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
Editing a directory entry. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
Deleting a directory entry. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
Exporting Directory dialing numbers. . . . . . . . . . . . . . . . . . . . . . . . 69
Importing Directory dialing numbers. . . . . . . . . . . . . . . . . . . . . . . . 70
Changing a directory number (DN) . . . . . . . . . . . . . . . . . . . . . . . . . 72
Searching the directory. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
Using information screens . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
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Logging off the Attendant PC. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

Tools menu
The Tools menu represents an important work area on the Attendant PC 
desktop as shown in Figure 6. This is where you transact, administer and set 
up the fundamental call processing activities. It is also a unified work area for 
making decisions on how to process or route a call. 

The Tools menu contains the following eight submenus:

• Directory: Contains directory names, telephone numbers, and other 
access information for you to use as needed.

• Feature List: Lists the features you selected from the Attendant PC 
Config menu. These features are accessible to you because they were 
programmed in advance on the switch.

• ICI List: Lists the ICI (Incoming Call Indication) keys that are available 
to you because they are programmed on the switch.

• TGB List: Trunk Group Busy keys that are accessible to you.

• ToolBox: Contains features, ICIs, and TGB keys that you have 
customized to administer the PC Attendant console activities.

• CPLUS Directory: Enables you to upload CPLUS directory files 
from a diskette.

• Log off: Logs you out of the Attendant PC console.

• Exit: Quits the Attendant PC software program.

Directory

Feature

ICI

TGB List

ToolBox

List

List
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Feature List
The Feature List contains fixed features that are programmed by your System 
administrator. To display these features, select Feature List from the Tools 
menu. Figure 6 shows the features accessible to your Attendant PC console. 

To activate a feature, double-click on the feature in the Feature List.

Figure 6
Feature List display window

Tip
Fixed

You can also use the  and 
 fixed feature buttons on the 

console to reroute and release 
calls.

Tip
Features

Fixed
Features

Use the View menu to 
display features as large 
or small icons, or in a list 
as shown in this figure.
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Fixed features

Fixed features are standard in all Attendant PC workstations and cannot be 
edited or removed. Table 2 lists the fixed features shown in Figure 6 on 
page 39. 

Flexible features

Flexible features are created when they meet the needs of the business they 
serve. A flexible feature is assigned by a system administrator and given a key 
label and definition in the Attendant PC software. 

Before a flexible feature may be accessed from the Feature List, it must be 
configured under the Flex Keys tab. 

Use Procedure 1 to configure a flexible feature to appear in the Features List.

Procedure 1
Configuring a flexible feature to 
appear in the Features List

1 Select Console Configuration from the Configuration menu.

2 Click the Flex Keys tab.

Table 2
Fixed features 

Alarm Centralized Attendant Service

Call Waiting Conferencee

Exclude Destination Exclude Source

Make Set Busy Night Service

Release Release Destination

Release Source Signal Destination

Signal Source
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3 Pull-down on one of the available Flex Keys and select the desired 
feature.

End of Procedure

Virtual features

Virtual feature keys allow you to consolidate multiple key strokes into one 
keystroke. Virtual features are created using the Features tab in the Console 
Configuration menu. To create Virtual features, see Figure 11 on page 45.

For example, if you want to place a call to a pager using the M2250 Attendant 
Console, several key presses are required:

• select a loop key

• dial the pager number

• pause 2 seconds

• press End-to-End Signalling key

• input your return number

• end with the pound key (#)

• press the Release button

Creating a Virtual feature for the above functions allows you to execute the 
functions with a single keystroke. 

Use Procedure 2 to create a Virtual feature key.

Procedure 2
Creating a Virtual feature key

1 Choose Console Configuration from the Configuration menu.

2 Select the Features tab.

3 Click New.

4 Type a description of the feature in the Feature Description text box.

5 Type the label that is to appear on the console in the Key Label text box.

6 Select Virtual in the Type group box.
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7 Click Processing.

Figure 7 shows the Feature Specification window.

Figure 7
Feature Specification window

8 Select the steps that make up the virtual feature.

Figure 8 shows the Processing Procedure window.

Figure 8
Processing Procedure window
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9 Highlight the appropriate processing steps in the Available Processing 
Steps list box and click Add. The steps appear in the Selected list box. 
Use the Remove button and the arrow buttons to edit the Selected list 
box.

10 Define each step in the Selected list box that requires a flexible key, an 
ICI key, or a number to be dialed.

• To assign flexible keys for the steps, click Flex Select. The Flex Key 
Selection window opens. For each step entitled “Press a flexible 
feature key,” select the appropriate flexible key from the Key list box. 
When all flexible keys have been assigned for the required steps, 
click OK. 

Figure 9 on page 43 shows the Flex Key Selection window.

Figure 9
Flex Key Selection window

• To assign ICI keys, click ICI Select. The ICI Select window opens. 
For each step entitled “Press an ICI key,” select the appropriate ICI 
key from the Key list box. When all ICI keys have been assigned for 
the required steps, click OK. 
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• To assign phone numbers, click Dial Number. The Static Dialing 
Assignment window opens. For each step entitled “Dial a number 
(Static),” enter the number to be dialed. When all numbers have been 
entered for the required steps, click OK.

Figure 10 shows the Static Dialing Assignment window.

Figure 10
Static Dialing Assignment window

11 Click OK.

End of Procedure

Use Procedure 3 on page 45 to use the Virtual feature.



 Working with the Tools menu  Page 45 of 270

Attendant PC Description, Installation, and Operation

Procedure 3
Using the Virtual feature

1 Scroll through the list in the Virtual List display window, as shown in 
Figure 11 on page 45. 

2 Double-click the light blue shaded Virtual Feature from the Features List.

Note: Definitions for all features, as well as ICI’s (Incoming Call 
Indicators) and TGB’s (Trunk Group Busy keys), are provided in the 
section “List of Terms” and also in the Glossary and other help screens on 
the Console.

Figure 11 shows the Virtual List window.

Figure 11
Virtual List display window

Virtual
Features
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ICI List
The ICI List contains the ICI (Incoming Call Indicator) keys. The ICI keys 
will help you: 

• identify the type of incoming calls queued

• prioritize call answering

• verify how many calls are in queue

• determine how long calls have been waiting

To answer a call associated with an ICI key, click on the flashing ICI 
lamp in the ICI List.

You can answer call using the loop keys, or you can give preference to a 
certain type of call, using the ICI keys. For example, to answer a WATS call 
before you answer the other calls, click the WATS ICI key. All other ICI 
indicators go off, and the WATS call is established. 

Besides telling you the nature of a call, the ICI indicator also gives you 
an idea of the number of calls of that type that are queued and how long 
the calls have been queued:

• steady on — one call has been queued for less than 20 seconds

• flashing — two or more calls are queued, or one call has been queued for 
more than 20 seconds 

ICIs are programmed by the System administrator then assigned to a key in 
the console. The software displays this list when you select the ICI List from 
the Console Configuration menu.

Note: You can also drag ICI keys from the ICI List and drop them into 
your personal Toolbox.

Source

Destination

Lamp

ICI Lists

Use the ICIs tab in the 
Console Configuration 
menu to assign a specific 
ICI for display in the ICI 
list.

ICIs tab
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Adding an ICI key

Use Procedure 4 to add an ICI key.

Procedure 4
Adding an ICI key

1 Click New to bring up the popup dialog shown in Figure 12.

Figure 12
ICI specification window

2 Define a new ICI Description, Key Label and path to the location of the 
default WAV file designated for audible signalling.

3 Click OK to save the ICI key.

The key label entry you created is now displayed on the ICI list that you 
selected from the Tools menu.

4 While still in the ICIs window, click the ICI Keys tab to associate a new ICI 
key with each number from 0-19, as described in “The ICI Keys tab” on 
page 92.

5 Click OK to save the ICI key.

6 Select the ICI List from the Tools Menu to see the new oval-shaped 
button associated with the ICI key assignment you just made. Figure 13 
on page 48 shows the ICI Key display window.

End of Procedure

 

Tip
The path and location 
of the default directory 
where the target WAV 
files reside are shown 
as: Click Help for detailed

information on ICI specifications.

Click the Play button to hear
the selected default sound.

ICIs List



Page 48 of 270  Working with the Tools menu

553-3001-320 Standard 4.00 July 2006

Using the ICI Keys page

Figure 13 displays the ICI Keys window on which you can pair up to twenty 
ICI keys with one of the key numbers (three ICI keys are defined in this 
sample window).

Use Procedure 5 to view the ICI keys display bar.

Procedure 5
Viewing the ICI keys display bar

1 Click the to associate an ICI key with each number from 0-19.

2 Select the ICI List from the Tools Menu to see the new oval-shaped 
button associated with the ICI key assignment you just made. 

Figure 13 shows the ICI Keys display window.

Figure 13
ICI Keys display window.

End of Procedure

ICI Keys tab

Click Help on how to assign ICI Keys
to the ICI Feature List.

Click, then select a number choice 
to associate an ICI key assignment.

 

 

.
 

Lists the ICIs that have 
been assigned using the 
New button.
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TGB keys
TGB (Trunk Group Busy) keys allow you to quickly and easily:

• determine if all trunks in a route or trunk group are busy

• busy out particular routes to outgoing calls

• deny certain users direct access to trunk groups

The button lamps in the TGB List show the status of each group of trunks. 

Use Procedure 6 to activate a TGB key.

Procedure 6
Activating a TGB key

Choose one of the following to activate a TGB key:

a. Click on the TGB lamp in the TGB List. 

Note: TGB keys are programmed by the system administrator.

b. You can also drag TGB keys from the TGB List and drop them into 
your personal Toolbox.

End of Procedure

Use Procedure 7 to add a TGB key.

Procedure 7
Adding a TGB key

1 Click New to bring up the popup dialog shown in Figure 14.

2 Define a new TGB Description and Key Label.

3 Click OK to save the TGB key.

The key label entry you created is now displayed in the TGB list that you 
select from the Tools menu.

Figure 14 on page 50 shows the TGB Specification window.

TGBs List
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Figure 14
TGB Specification window

4 While still in the TGBs window click the TGB Keys tab to associate a new 
TGB key with each number (0 to19) as shown in Figure 15.

Figure 15
TGB Keys display window

5 Click OK to save the TGB key.

 

Lists the TGBs that 
have been assigned 
using the New button.

Click Help for detailed
information on TGB specifications.

TGB Keys tab

Click Help on how to add TGB Keys.
.

Select a number choice to
associate a TGB key
assignment.
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6 Select the “TGBI List” from the Tools Menu to see the new shaped 
“button” associated with the TGB key assignment you just made.

End of Procedure

Building a ToolBox
The Attendant PC ToolBox, allows you to store the features that you use the 
most in one window. Once you build a toolbox, you no longer need to display 
the ICI and TGB directory windows except as needed. All features (fixed, 
flexible, and virtual) are now available to you in one central display window 
(Figure 16 on page 52) instead of three. 

Each attendant’s toolbox is personalized. When an attendant logs in, no 
matter which console is being used, the attendant’s toolbox appears with the 
appropriate features.

To build your toolbox, drag and drop features from the Feature List, ICI 
(Incoming Call Indicators) List, and TGB (Trunk Group Busy) List windows 
into the Toolbox window.

Use Procedure 8 to build your toolbox.

Procedure 8
Building your toolbox

1 Choose Toolbox from the Tools menu.

An empty Toolbox window is displayed on your desktop.

2 Select Feature List from Tools on the Attendant PC main screen.

The Feature List window appears on your desktop.

3 Select ICI List from Tools on the main screen.

The ICI List window appears on your desktop.

4 Select TGB List from Tools on the main screen.

The TGB List window appears on your desktop.

5 Drag and drop the features you use the most from the Feature List 
window to the Toolbox window.
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6 Repeat Step 3 for the ICI List keys and the TGB List key. 

Figure 16 shows a sample of the Toolbox window.

Figure 16
Sample Toolbox window

End of Procedure

Accessing the CPLUS Directory
The following procedure shows you how to use the CPLUS Directory 
function to access CPLUSDIR. BTR directory numbers from a diskette for 
uploading into the Attendant PC Data folder for transfer to your personal 
Directory.

Use Procedure 9 to access CPLUSDIR.BTR directory numbers.

Procedure 9
Accessing CPLUSDIR.BTR directory numbers

1 Select CPLUS Directory from the Tools menu.

A dialog displays prompting you that the CPLUS directory file 
CPLUSDIR.BTR cannot be found. See Figure 17 on page 53.

You can resize or 
expand the bottom 
edge and sides of the 
Toolbox window with 
the mouse to enlarge it 
in order to list more 
features and keys.

Tip

TGB List

ICI List

Feature List
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Figure 17
CPLUS Directory dialog

2 Click Yes to locate the CPLUS file.

The CPLUS Directory “Look in” window is displayed. See Figure 18.

3 Click the  to display the 31/2 Floppy (A:) drive icon.

Figure 18
CPLUS Directory Look in display

4 Select the CPLUSDIR.BTR file and click Open.

The CPLUSDIR.BTR file is uploaded to the Attendant PC Data folder.

End of Procedure

Directory
The Directory is a principal component of the Tools menu. All Attendant PC 
call processing activity is initiated from this key resource. The Directory also 
records individual records for fast information retrieval.

Overall, the Directory functions as a “mini console” containing a two-line 
display, Position Busy, Rls Dst, CAS buttons, Mini-keypad, and Directory 
icons and Directory Help facility. See Figure 19. You can also assign “hot 

Click here to access the 
drop down devices window.

Drag and drop a 
directory
entry to the  icon 
to dial a user’s 
number 
automatically.

Tip
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keys” to one or more keys to activate a specific function if you prefer using 
keyboard shortcuts. See “The Hotkeys tab” on page 79.

Note: The Directory console functions just like the main console except 
there is no global console Help, dialpad numbers or loopkeys which 
allow you to assign an outgoing call or answer an incoming call.

Figure 19
Directory console display

Starting the Directory

You can launch the Directory in two modes—with the mini-console attached 
or with the default Directory List only. 

Use Procedure 10 on page 55 to enable the mini-console option.

Status
indicator

Position
Busy

DirectoryMini-keypad

Position Busy
button

Centralized Attendant
Service button

Release Destination
button

Status Indicator

Use the Rls Dst button to 
release a called party, 
unanswered ringing, busy 
signal or an extension 
requesting a transfer.

Use the CAS button to 
automatically reroute calls 
to a centralized attendant at 
the main location.
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Procedure 10
Enabling the mini-console option

1 Select the Tools menu and click Directory.

2 Click the Directory menu and Properties to display the Directory 
Properties page. See Figure 20.

3 Check the box labelled Include console functions.

4 Click OK.

The Directory with attached mini-console is displayed on your workstation 
desktop.

Figure 20
Main Properties page

Note: Leave the box labelled Include console functions unchecked to 
display the Directory without the mini-console option as shown in 
Figure 20.

Indicate a  in the 
box to "Include 
functions " to launch
the directory console

Click the Help button to open a book or use
the Index tab to locate information on settin
up the directory display.
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Figure 21
Directory mini-console and Directory default displays

End of Procedure

Creating a Directory entry

A Directory entry or “row” listed in the work area of the Directory window 
relates to a record for that entry. See Figure 23 on page 58. Each record 
defines a profile which is contained within the following two tabs:

General tab  

Address tab  

— Extension DN — Last and First Name and Title

— Access Code — Status

— Street Address — City

— State — Postal Code (Zip)

Tip

You can assign "hot keys"
to one or more keys to 
activate a specific function
if you prefer using 
keyboard shortcuts.
See "The Hotkeys tab" on
page 60. 

Directory with mini-console option Default Directory
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To obtain help at any time on “Getting Started” and “Using the Directory”, 
click on Contents in the Directory Help facility.

Note: You can browse a view of the Directory Window by pressing the 
F1 key.

Use Procedure 11 to create a directory entry.

Procedure 11
Creating a directory entry

1 Select Directory from the Console Tools menu.

Figure 22 shows the Console Tools menu display window. 

Figure 22
Console Tools menu display.

Click Directory
to set up your 
personalized
database of dialing
numbers.
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Figure 23 on page 58 shows the Directory display window.

Figure 23
Directory display window

2 Click on Directory to select the New page.

Enter General information for each person you want listed in your 
directory. 

Figure 23 shows the General tab display window.

Console – displays keyboard shortcuts
or “Hot Keys”.

Information – displays the Shift screen
with key definitions.

Help – provides directory help
information on directory related topics.

Directory – displays menu options that

Use the Tab key 
instead of the mouse 
to move through the 
various text fields 
and buttons 
selections in any 
Directory tab 

Tip



 Working with the Tools menu  Page 59 of 270

Attendant PC Description, Installation, and Operation

Figure 24
General tab display

3 Click Apply and then OK.

The new entry is displayed in the Directory window.

Note: If the This is not an Individual checkbox is selected, the Directory 
displays two face icons rather than one. 

4 Double click on the newly defined entry to display additional Directory 
tabs.

5 Click the Address tab to record profile information for each individual 
entry and then click OK.

Figure 25 shows the Address display tab window.

Click the Help button to see Help Topics on
providing general information for a directory
entry.
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Figure 25
Address display tab

End of Procedure

Use Procedure 12 to set the Directory properties.

Procedure 12
Setting the Directory properties

1 Click Directory to select Properties.

The Directory Properties page displays five tabs. 

Specify the columns that appear on your directory display screen and in 
what order they should appear. See Figure 26 on page 61.

2  Click Columns.
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Figure 26
Columns display window 

The User Data tab allows you to label custom columns. Column labels 
that you type here appear on the Columns tab, where they can be 
selected to display in the Directory window. See Figure 26.

Note: Custom columns can be used to order the directory. For example, 
if you label a column Site and display the column in the Directory window, 
clicking on the column label for Site arranges the directory by site in 
ascending alphabetical order.

End of Procedure

Use Procedure 13 on page 61 to label custom columns for display in the 
Directory window.

Procedure 13
Labeling custom columns for display in the 
Directory window

1 Click User Data. 

Figure 28 on page 63 shows the User Data display window.

Tip
Double click on a column 
item to move it quickly 
between “not displayed” to 
“displayed” areas. 

These Help topics contain 
green underlined text. You 
can click the green text to 
see descriptions for setting, 
positioning, and removing 
columns.

Click the Help button to see instructions f
setting up the directory display.
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2 Click Apply and then OK.

Use the Info tab to label tabs for storing additional information on 
directory entries. You can label from 1 to 14 tabs. For each label you 
enter, a tab appears in the Directory Properties window. For further 
information on using the information screens, refer to See “Using 
information screens” on page 73.

Figure 27 shows the Directory Properties window.

Figure 27
Directory Properties window.

Figure 28 on page 63 shows the User Data display window.

The directory contains two user 
definable columns. Enter a
short, one- or two-word label for
these columns.

Click the Help button to see
information on labeling custom
columns.
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Figure 28
User Data display window

Type the appropriate information in the two text boxes. Each text box is 
marked with the label assigned in the Directory Properties dialog box. 

Column labels that you type here appear on the Columns tab, where they 
can be selected to display in the Directory window.

3 Click the Shift tab to customize labels. 

Figure 30 on page 65 shows the Shift display window.
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Figure 29
Shift display window

4 Enter free-form text to define a label for an entry. 

5 Click OK to accept the changes.

End of Procedure

Use Procedure 14 on page 65 to label tabs for the Directory entry window.
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Procedure 14
Labeling tabs for the Directory entry window

1 Click Info.

Figure 30
Info display window

2 Click Apply and then OK.

End of Procedure

Access codes

Access Codes are one or more digit(s) dialed by a console within the 
telephone system prior to dialing an outside call. These codes determine 
access to features and trunk facilities so that the Attendant PC can route calls 
correctly.

Figure 31 on page 66 shows the Access display window.

Use Procedure 15 on page 66 to define the access codes for dialing outside 
numbers.

Click the Help button to see information on
creating label tabs.
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Procedure 15
Defining access codes

1 Click Access Codes. 

Figure 31
Access display window

2 Click Apply and then OK.

End of Procedure

These digits make up the 
access code.

Valid characters include: 
0-9, T, and comma (,). All 
other characters are 
ignored.

Click the Help button to see information on
creating label tabs.

 If the access number must have Touch Tone 
DTMF, include a T immediately before and 
after the portion that requires the tones.

Prompts you for the new access code

Click the Delete button to remove

 

Add New Access Code

a selected access code.

Delete an Access Code

 for an entry.
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Status codes

Status Codes provide information about the user or the extension. The status 
codes can be selected for an entry and displayed in the Directory window. 

Figure 32 shows the Status display window.

Use Procedure 16 to create status codes for a selected entry.

Procedure 16
Creating Status Codes

1 Click Status Codes.

Figure 32
Status display window

A brief description that 
explains what the status 
means.

A word or short phrase 
that identifies the status 
such as Vacation or In.

These Help topics contain green 
underlined text. You can click the 
green text to see descriptions for 
creating and assigning status codes to a 
user

Prompts you for the new status code

Click the Delete button to remove

 

Add New Status Code

the selected status code.

Delete a Status Code

 for an entry.
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2 Click Apply and then OK.

End of Procedure

Editing a directory entry

Use Procedure 17 to edit or modify any Directory tab displays.

Procedure 17
Editing a directory entry

1 Double click the directory entry to display additional Directory tabs.

2 Click Edit. Make the appropriate changes.

3 Click OK to accept changes.

End of Procedure

Deleting a directory entry

Use Procedure 18 to delete a directory entry.

Procedure 18
Deleting a directory entry

1 Double click the directory entry you wish to delete.

2 Click Delete.

3 Click Yes to confirm deletion.

4 Click OK.

End of Procedure
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Exporting Directory dialing numbers

Use Procedure 19 to export Directory numbers. 

Procedure 19
Exporting Directory numbers

1 Click Directory to select Export.

Figure 33 on page 69 shows the Export display window.

2 Click New to enter a name for the new export job.

Figure 33
Export display window

Figure 34 on page 70 shows the Export Job display window.

Click Edit (Figure 24) to modify file
information and columns for the exported

Click Delete to remove an export
 directory job.

directory job.Click the Help button to 
see information on 
Exporting jobs using 
the Contents, Index, 
and Find tabs.

Tip



Page 70 of 270  Working with the Tools menu

553-3001-320 Standard 4.00 July 2006

Figure 34
Export Job display window 

3 Click OK.

End of Procedure

Importing Directory dialing numbers

Use Procedure 20 to import Directory numbers.

Procedure 20
Importing Directory dialed numbers

1 Click Directory to select Import.

Figure 35 on page 71 shows the Import display window.

2 Click New to enter a name for the new import job.

Indicate file information
(default is Comma
Separated) and output
file name or location
of the export job.

Select the columns you want
included in the export file.

Double click on a 
column item to move it 
quickly between “not 
displayed” to 
“displayed” areas.

Tip
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Figure 35
Import display window

Figure 36 shows the Import Job display window.

Figure 36
Import Job display window.

3 Click OK.

End of Procedure

Click Edit (Figure 24) to modify file
information and columns for the imported

Click Delete to remove an import
 directory job.

directory job.
Click the Help button 
to see information on 
Importing jobs using 
the Contents, Index, 
and Find tabs.

Tip

Double click on a 
column item to move it 
quickly between “not 
displayed” to 
“displayed” areas.

Tip

Indicate File Information (default is 
Comma Separated) and Output File 
Name or location of the import job.

Select the columns you want 
included in the import file.
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Changing a directory number (DN)

The Change DN function enables you to quickly access and transfer a 
directory entry to a new directory number as shown in Figure 37.

Use Procedure 21 to change an existing directory number.

Procedure 21
Changing a Directory number

1 Click Directory to select Change DN.

The Change DN dialog box is displayed. See Figure 37.

Figure 37
Change DN display window

2 Click OK.

End of Procedure

Searching the directory

Use the Search Directory function to locate directory entries by name or 
directory number See Figure 38 on page 73.

Indicate the new DN (dialing number) for a direct
entry. All directory information is transferred
to the new DN.

Click the Help button to see Help Topics on
changing the DN using the Contents, Index,
and Find tabs.
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Figure 38
Search Directory display

Using information screens

Up to fourteen information screens can be defined, to give additional 
information on entries in the directory.

Use Procedure 22 to create an information screen.

Procedure 22
Creating an information screen

1 Select Properties from the Directory menu. 

The “Directory Properties” window appears.

2 Select the Info tab.

3 Type a label for each information screen to be created.

4 Click OK.

End of Procedure

Use Procedure 23 to add information to an information screen.

Procedure 23
Adding information to an information screen

1 Double-click the directory entry where you wish to enter information.

2 Click on the information screen tab you have defined to which you wish to 
add information.

3 Enter the information.

Indicate a name, first or last, or 
DN and click OK to start the 
search process.
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4 Click OK.

End of Procedure

Use Procedure 24 to add information using the information menu.

Procedure 24
Adding information using the Information menu

1 Select the directory entry for which you want to view information.

2 Click on the Information menu and select the information tab to which 
you wish to add information.

3 Enter the information.

4 Click OK.

End of Procedure

Use Procedure 25 to access an information screen.

Procedure 25
Accessing an information screen

1 Select the directory entry for which you want to view information.

2 Click on the Information menu and select the information tab you wish to 
view.

3 Click OK when finished.

End of Procedure

Logging off the Attendant PC
Use the Log off function when you are ready to end your time at the console. 
All of your personal console settings such as the ToolBox, Directory and 
customized features (lists) are automatically saved.

For further information on any of the Tools topics discussed in this section, 
consult the Help Facility.
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Table 3 lists some Help facility topics.

Table 3
Help facility subjects

To learn about... Search the Help Index for...

Setting up the directory display dial

Ordering entries in the directory dialing a number

Searching the directory column label

Assign a status code status

Dialing out dial

Building a Toolbox toolbox
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Description
This section describes how to set up your Attendant PC console, discusses 
considerations that affect how you configure your console and presents a 
series of step-by-step procedures designed to familiarize you with the 
fundamental aspects of configuring your console.

Configuration menu
The Config menu displays four commands:

• Console Configuration
Lets you set up your Virtual Features, ICI, and TGB keys.

• Interface Properties
Lets you specify voice volume, call waiting, handset, relay and 
diagnostic characteristics.
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• Configure Port
Enables you to select a COM port for the Attendant PC.

• Change Password
Permits you to set passwords for multiple attendants.

Console Configuration 

When you select Console Configuration, Attendant PC displays the following 
tabs:

• General • Flex keys

• ICI • Hotkeys

• ICI keys • Consoles

• TGB • Attendants

• TGB keys • Features

The General tab 

Within the General tab, the system administrator or attendant must provide a 
response to each of the following items listed on the General page. See 
Figure 39 on page 79. This ensures that your console is fully configured. The 
following items except the password (optional) must be supplied:

• Enter the access number for Express Mail.

• Click the checkbox if a password is required to operate the Attendant PC.

• Indicate the location and name of the default WAV file for audible 
signaling.

• Indicate the pause length, in milliseconds; the duration of a delay that is 
generated when a comma appears in a typed-in number for dialing.

Figure 39 on page 79 shows the General Tab display window.

Tip

 

Make sure that 
End-to-End Signalling 
(EES) is defined as a 
flexible feature.

Select the location and 
WAV file for audible 
signalling by opening the 
folder icon.

Requires an assigned 
access number 
assignment before the mail 
tool can be displayed on 
the main console display.
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Figure 39
General tab display

Use Procedure 26 on page 79 to configure the Voicemail icon.

Procedure 26
Configuring the Voicemail icon

1 First, ensure that End-to-End Signaling (EES) is set up as a flexible 
feature by verifying it is listed in the Feature List under the Tools menu.

2 Choose Console Configuration... under the Config menu.

3 Select the General tab.

4 Type the access number for Express Mail in the appropriate text box.

End of Procedure

The Hotkeys tab

Hotkeys allow you to assign shortcut keyboard commands to commonly 
performed tasks. 

Use Procedure 27 on page 80 to create a HotKey.

Click the Play button to hear
the selected default sound.

Click the Help button to see a list of
general configuration options.

Tip
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Procedure 27
Creating a HotKey

1 Select Console Configuration from the Configuration menu.

2 Select the Hotkeys tab.

3 Select a task from the Hotkey Activities window.

4 Select New Hotkey.

5 Type the new hotkey shortcut. To select a two or three key combination 
hotkey press and hold one or more of the Alt, Ctrl, and Shift keys then 
press the desired hotkey.

6 Click OK to exit.

Figure 40 shows the Hotkeys display window.

Figure 40
Hotkey tab display

Hotkeys tab
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Note: There are a few keys that, although valid, are probably not good 
choices for hotkey assignments. These would include the F1 key, single 
key hotkeys that are numbers, and other keys that you would normally 
use in the day to day operation of your console. A two key combination 
such as Alt+H is always preferable to a single key such as H.

End of Procedure

The Consoles tab

The Consoles tab is where you register the Attendant PC console software and 
define the WAV file used for audible signalling. See Figure 41 on page 81. 

Enter the following information:

• console serial number

• full name of the console

• name of WAV file designated for audible signaling

Figure 41 shows the Consoles display window.

Figure 41
Consoles display window

Tip

 

 

We encourage you to 
register your Attendant 
PC application by 
telephone as soon as 
you have installed the 
software.

Select the location and 
WAV file for audible 
signalling by opening the 
folder icon.

Click Register to display 
the Console Registration 
form. 

Click the Play button to hear
the selected default sound.
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Click Register to display the Console Registration window. Provide the 
registration code and note your company’s name, address, installation code, 
and serial number before you telephone the software manufacturer.

The Attendants tab

The Attendants tab displays a security page that allows privileges to each 
person identified by role and full name. A indicates specific access rights 
for individual user profiles.

Figure 42 shows the Attendants display window.

Figure 42
Attendants display window

 

Click each level of access 
rights for a new or existing 
attendant.

To add an additional 
attendant, click New. A 
“New Attendant” dialog box 
is displayed as shown 
below. The user name is 
limited to 20 characters.

Tip

Click the Help button to see a list of
Attendant properties and descriptions.
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The Features tab

The Features tab displays the following flexible features that are programmed 
in advance by the system administrator: 

• Auto Dial • Automatic Wake-Up

• Barge-In • Break-In

• Busy Verify • Call Park
• Calling Party Number • Charge Account

• Controlled Class of Service • DID Route Control

• Display Calls Waiting • Display Destination
• Display Source • Do-Not-Disturb Group/Individual

• Malicious Call Trace • Message Cancellation

• Message Indication • Meter
• Paging • Routing Control

• Speed Call Controller • System Speed Call Controller

• Stored Number Redial

Prompts you for the new attendants name

Click the Delete button to remove an attendant

or user ID. 

You can assign a password for each new

Add New Attendant

attendant. Assigning a password is optional.

from the list of identified attendant users.

New Attendant Password

Delete New Attendant
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Use Procedure 28 to add a flexible feature.

Procedure 28
Adding a flexible feature

1 Make a list of up to twenty features you would like on your Attendant PC 
Console. 

Note: Every preferred feature must be programmed in advance on the 
system for use from your PC workstation display.

2 Select Features to access the Features script page. 

A page is displayed with blank areas for entering the feature description, 
key label, and type (Virtual or Flexible Feature Key).

Figure 43 shows the Features display window.

Figure 43
Features display window

 

 

After you have 
defined your feature 
key and click OK, 
your new feature is 
displayed in the 
features list.

Click Edit to modify a flexible
 key feature assignment.

Click Help for detailed instructions
on adding a new feature.

Click Remove to delete a flexible
 key feature assignment.
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3 Click OK. Your feature is now displayed on:

• the Features page of the Console Configuration menu, shown 
above in (Figure 43)

• the Flex Keys list, shown in Figure 43 on page 84. 

Note: Many of these features described later in this section are defined 
briefly in the section “List of terms” on page 251.

End of Procedure

Creating Virtual feature keys

One of the key benefits of the Attendant PC is the ability to create Virtual (or 
customized) features to consolidate multiple keystrokes into one keystroke.

For example, when placing a call to a pager using a M2250 Attendant 
Console, several key presses are required:

• select a loop key

• dial the pager number

• pause for 2 seconds

• press the End-to-End Signaling key

• input your return number

• end with the pound key (#)

• press the Release button

Creating a Virtual Feature for the above functions allows you to execute the 
functions with a single keystroke.

Use Procedure 29 to create a Virtual feature key. 

Procedure 29
Creating a Virtual feature key

1 Choose Console Configuration from the Configuration menu.

2 Select the Features tab.

3 Click New.
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4 Complete the following information:

• Type a description of the feature in the Feature Description text box.

• Type the label that is to appear on the console in the Key Label text 
box.

• Select Virtual in the Type group box.

5 Click Processing.

Figure 44 shows the Feature Specification window.

Figure 44: Feature Specification window
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6 Select the steps that make up the virtual feature.

Figure 45 shows the Processing Procedure window.

Figure 45: Processing Procedure window

Highlight the appropriate processing steps in the Available Processing 
Steps list box and click Add. The steps appear in the Selected list box. 
Use the Remove button and the Arrow buttons to edit the Selected list 
box.

7 Define each step in the Selected list box that requires a flexible key, an 
ICI key, or a number to be dialed.

• To assign flexible keys for the steps, click Flex Select. For each step 
entitled “Press a flexible feature key,” select the appropriate flexible 
key from the Key list box. When all flexible keys have been assigned 
for the required steps, click OK.

Figure 46 on page 88 shows the Flex Key Selection window.
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Figure 46: Flex Key Selection window

• To assign ICI keys, click ICI Select. For each step entitled “Press an 
ICI key,” select the appropriate ICI key from the Key list box. When 
all ICI keys have been assigned for the required steps, click OK.
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• To assign phone numbers, click Dial Number. For each step entitled 
“Dial a number (Static),” enter the number to be dialed. When all 
numbers have been entered for the required steps, click OK.

Figure 47 shows the Static Dialing Assignment window.

Figure 47: Static Dialing Assignment window

8 Click OK.

To use the Virtual Feature, locate and double-click the light-blue shaded 
Virtual Feature from the Feature List.

End of Procedure

The Flex Keys tab 

You can assign features called Flexible Features to Flex Keys which enable 
you to access flexible features quickly. 

Figure 48 on page 90 shows the Flex Keys window.
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Use Procedure 30 to display features assigned to Flex keys.

Procedure 30
Displaying features assigned to Flex Keys

1 Click the button to access the pull-down menu that displays one 
Flexible Feature chosen by you for each key number. 

The Flexible Features defined here have been predefined in advance by 
systems staff for the system.

Figure 48
Flex Keys display window

To view the key or lamp that you will use to activate the feature:

2 Select Feature List from the Console screen’s Tools menu 

The new feature is displayed as a light blue lamp symbol in the Features 
List window. See Figure 43 on page 84.

End of Procedure

The ICI tab

Adding an ICI key enables you to create labels and edit some features of ICIs. 
ICIs are designated in the System by systems staff, then assigned to a key in 

 

 

.
 

Assign a flexible 
feature to a flex key 
number and click 
OK.

Click Help on how to assign Flex Keys
to the PC console screen.
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the console. This list is displayed when you select the ICI’s List from the 
Console Configuration menu.The following procedure shows you how to list 
the ICI features that are available. The available ICI keys are:

Figure 49 shows the ICI display window.

Figure 49
ICIs display window

Note: ICI2 must be defined in your System in order to assign ICI keys 
from 10 to 19. For further information regarding ICI2, consult your 
system administrator.

Use Procedure 31 on page 92 to add an ICI key.

• Dial “0” • Call Forward No Answer; 
Call Forward Busy

• Intercept • Interpositional Call

• Listed Directory 
Number

• LD0 (local line 0), LD1

• Message Center • Recall
• TIE, WATS • Fx (Foreign Exchange)

 

 

.
 

Lists the ICIs that 
have been created 
using the New button.

Click Help on how to assign ICI Keys
to the ICI Feature List.

Click Edit to modify a new or existing

Click New to create an ICI description,
Key Label and path to the location
of the WAV file designated for audible
signalling.

ICI description.

Click Remove to delete an ICI
key description.
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Procedure 31
Adding an ICI key

1 Click New. The ICI Specification window opens.

Figure 50 shows the ICI Specification window.

Figure 50.
ICI specification window

2 Define a new ICI Description, Key Label and path to the location of the 
default WAV file designated for audible signalling.

3 Click OK to save the ICI key.

The key label entry you created is now displayed on the ICI list that you 
selected from the Tools menu.

4 Click the ICI Keys tab to associate a new ICI key with each number from 
0 to 19 as described earlier for “Flex keys” on page 89.

5 Click OK to save the ICI key.

6 Select the ICI List from the Tools Menu to see the new oval-shaped 
button associated with the ICI key assignment you just made. You can 
see a sample ICI List in Figure 51 on page 92.

The ICI Keys tab

Figure 51 on page 93 displays the ICI Keys window on which you can pair 
up to twenty ICI’s with one of the key numbers (just two ICI keys are defined 
in this sample window).

To view the ICI Keys display bar, click the to associate an ICI key with 
each number from 0 to 19.

 

Tip
The path and location 
of the default directory 
where the target WAV 
files reside are shown 
as: Click Help for detailed

information on ICI specifications.

Click the Play button to hear
the selected default sound.

ICIs List
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Select the ICI List from the Tools Menu to see the new oval-shaped button 
associated with the ICI key assignment you just made. 

Figure 51 shows the ICI Keys display window.

Figure 51
ICI Keys display window.

Click Help on how to assign ICI Keys
to the ICI Feature List.

Click, then select a number choice 
to associate an ICI key assignment.

 

 

.
 

Lists the TGBs that 
have been assigned 
using the New button.
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The TGB tab

TGBs (Trunk Group Busy) keys enable you to deny users access to trunk 
groups and have calls to those trunk groups sent to your console instead. The 
lamps in the TGB list window show the status of each group of trunks. You 
can create up to ten trunk group busy (TGB) keys that deny users access to 
one or more trunk groups from 0 to 9. 

Figure 52 shows the TGB display window.

Figure 52
TGBs display window.

Note: The customer data block (CDB) must be configured for ICI2 to 
use TGB keys.

Use Procedure 32 to add a TGB key.

Procedure 32
Adding a TGB key

1 Click New to bring up the popup dialog shown in Figure 53 on page 95.

2 Define a new TGB Description and Key Label.

 

.
 

Lists the TGBs that 
have been created 
using the New 
button.

Click Help on how to add a new TGB
.

Click Edit to modify a new or existing

Click New to create a TGB description
and Key Label. 

TGB description.

Click Remove to delete an TGB
 key description.

key to the console.
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3 Click OK to save the TGB key.

The key label entry you created is now displayed in the TGB list that 
you select from the Tools menu.

Figure 53 shows the TGB Specification window.

Figure 53
TGB Specification window

4 While still in the TGBs window click the TGB Keys tab to associate a new 
TGB key with each number from 0 to 19 as described for Flex Keys on 
page 90.

Figure 54 on page 96 shows the TGB Keys display window.

TGBs List

Click Help for detailed
information on TGB specifications.
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Figure 54
TGB Keys display window

5 Click OK to save the TGB key.

6 Select the “TGB List” from the Tools Menu to see the new shaped 
“button” associated with the TGB key assignment you just made.

End of Procedure

Interface properties

The Interface Properties screen displays five tabs, each of which allows you 
or your system administrator to perform a different setup task.

The Alerter tab

The Alerter page allows you to control alert tone characteristics. The system 
plays the alert tone for operator alert conditions, including incoming calls.

Figure 55 on page 97 shows the Alerter display window.

Click Help on how to add TGB Keys.
.

Select a number choice to
associate an TGB key
assignment.

 

Lists the TGBs that 
have been assigned 
using the New 
button.

TGBs List
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Figure 55
Alerter display window

Note that the above screen provides: 

• a check box to indicate that you want alert tones provided

• mouse-operated slides on the screen to set volume and pitch levels

Call Waiting tab

The Call Waiting tab allows you to notify the system whether you want a Call 
Waiting tone via a checkbox. In addition, a mouse-operated slide is provided 
so you can determine the volume of the Call Waiting tone.

Figure 56 on page 98 shows the Call Waiting display window.

Click Help on how to configure alert
tones for incoming calls.

Tip

Indicate a in 
the box for enabling 
of alert tones.

Adjust volume and 
pitch with slide settings 
using the mouse.
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Figure 56
Call Waiting display window

Handset tab

You have a choice of connecting any of three receiving units to the Attendant 
PC:

• Handset

• Headset 1 (one earpiece)

• Headset 2 (two earpieces)

Click the name of the device you intend on using on the Handset page shown 
in Figure 57 on page 99.

 

Indicate a in the 
box for enabling of alert 
tones.

Adjust volume and pitch 
with slide settings using 
the mouse.

Click Help on how to configure alert

.

tones provided by the interface unit
for Call Waiting.

To return to the list of
topics, click Help Topics
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Note: Make sure you plug the headset or handset into the Attendant PC 
correctly. If you plug it in upside down, callers will not be able to hear 
your voice.

Figure 57
Handset display window

Note: You must make a choice when you are using a headset. Carbon 
headsets are not supported.

• Headset 1 — applies to the Plantronics-type headset

• Headset 2 — applies to the Liberation/GN Netcom-type headset

Relay tab

The Attendant PC uses relays to configure how a telephone may be answered 
when the attendant is not available, such as during an emergency (fire, 
earthquake), or off-hours (night or weekend service). For example, a 
recording may play during a call, and a night/weekend call may be transferred 
to someone in the company’s security personnel. Each relay triggers the 
applicable program from the system software.

Figure 58 on page 100 shows the Relay display window.

Click Help indicate the type of device

.

you are using and set the volume for
voice communication.
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Figure 58
Relay display window

Diagnostics tab

The Diagnostics tab allows you or the system administrator to perform the 
following actions:

• Self Test button to initiate a diagnostic self test on the PC Console 
Interface Unit (PCCIU).

• Reset button to reset the PCCIU to its default status.

Note:  Performing a Reset could result in loss of current information.

• Send LoopBack button to check communication between the 
Attendant PC and the system.

Figure 59 on page 101 shows the Diagnostics display window.

Click Help for information on setting

.

the General Purpose relay and to view
the current state of the Night Service
and Emergency relays.

 

Indicate a in the 
box for enabling 
General Purpose 
Relay.
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Figure 59
Diagnostics display window

Configure Port

The Configure Port option listed on the Config menu allows you to select a 
COM port which is required for your Attendant PC. 

An open COM port permits a connection between your PC workstation and 
the Attendant PC.

Figure 60 shows the COM port display window.

Figure 60
COM Port display window

Click Help for information on running

.

a diagnostic test on the interface unit
or to reset the interface unit.
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Change Password

The Change Password option listed on the Config menu allows you to enter a 
new password and verify the change by reentering the password. 

Figure 61 shows the Change Password display window.

Figure 61
Change Password display window

For further information on any of the Console Configuration topics discussed 
in this section, consult the Help Facility.
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Table 4 lists some Help Facility subjects.

Table 4
Help Facility subjects

To learn about... Search the Help Index for...

Editing general parameters
Requiring a password
Setting up the voice mail icon

General

Attendants
Edit TGBs
TGB List

TGBs

Adding a flexible key to the PC 
console screen
Building an attendant’s toolbox
Creating a virtual feature

Features

Adding an ICI key to the PC 
console screen
ICI Keys
editing ICIs

ICIs
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Attendant PC call processing
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Answering a call
Calls are queued in order of arrival. All calls are presented to loop 0 if idle. If 
a call on loop 0 has been placed on hold, the next call in queue will be 
presented to loop 1, and so on. A maximum of six calls may be processed or 
held on the console.

Use Procedure 33 to answer a call.

Procedure 33
Answering a call

1 You receive a call and hear a tone. The Source indicator flashes.

2 Click the appropriate loop indicator. The tone stops and the Source 
indicator goes on steadily; you are connected to the caller.

Note: To give priority to a certain type of call, answer by clicking the ICI 
key rather than an idle loop key. You are connected to the call regardless 
of its place in the queue. 

End of Procedure
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Extending a call to an idle extension
After you have answered a call, you can extend it to the extension the caller 
requests.

Use Procedure 34 to end a call to an idle extension. 

Procedure 34
Ending a call to an idle extension

1 Dial the requested extension.

2 To end your connection before the called party answers, click the 
Release button immediately. If the called party does not answer within a 
set time (usually within 30 seconds), you are recalled. 
Otherwise, wait for an answer. The Destination indicator lights steadily 
upon answer.

3 Click the Release button to connect the caller and called party and to end 
your connection to the call.

End of Procedure

Extending a call to a busy extension (with Camp-on)
After you have answered a call, you can extend it to the extension the caller 
requests.

Use Procedure 35 to extend a call to a busy extension (Camp-on).

Procedure 35
Extending a call to a busy extension 
(with Camp-on)

1 Dial the requested extension.

The Excl Src indicator lights during dialing. The Destination indicator 
flashes; the extension is busy.

2 Do one of the following:

a. If you do not hear a busy signal and the caller wishes to wait, you can 
camp the call onto the busy extension by clicking the Release button. 
If you do hear a busy signal after dialing the requested extension, 
either a call is already camped onto that extension, or Camp-on is not 
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allowed on that extension.
The indicator goes on; you are free to process other calls.

b. If you do hear a busy signal after dialing the requested extension and 
the caller wishes to call back later, click the Rls Dst button, and then 
the Release button to end your connection in the call.
The Destination indicator goes off; the called extension is released 
from the console. The Release indicator goes on; you are free to 
process other calls.

Note: If a camped call is not answered within the set time, it is returned 
to you.

End of Procedure

Extending a call to voice mail
If a called party does not answer and/or a call is recalled to the attendant, you 
can extend the call to voicemail.

Use Procedure 36 to extend a call to voicemail.

Procedure 36
Extending a call to voicemail

1 Dial the requested extension.

2 If the party does not answer or the call is recalled to the attendant, drag 
the number from the display and drop it on the Voicemail icon in the 
toolbar. You can also drag a number from the Directory and drop it on the 
Voicemail icon in the toolbar.

Note: If the Voicemail icon does not appear in the toolbar, contact your 
system administrator.

End of Procedure

Extending a call to a busy extension (with Hold)
To extend a call to a busy extension which is not allowed camp-on, or which 
already has a call camped onto it, you can place the caller on hold. You must 
then reenter the call periodically to see if the extension is free.
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Use Procedure 37 to extend a call to a busy extension (Hold)

Procedure 37
Extending a call to a busy extension (with Hold)

1 Dial the requested extension. 

The Excl Src indicator in the Feature List goes on during dialing. You hear 
a busy signal and the Destination indicator flashes; the extension is busy 
and not allowed camp-on.

2 Click the Rls Dst button.

The Destination indicator goes off; the called extension is released from 
the console.

3 Do one of the following:

a. If the caller wishes to call back later, click the Release button. The 
Release indicator goes on; you are free to process other calls.

b. If the caller wishes to wait, click the Hold button, then the Release 
button to end your connection in the call. The loop indicator flashes 
slowly. The Release indicator goes on; you are free to process other 
calls.

4 Check periodically to see if the extension is free. To reenter the call, click 
the loop key beside the slowly flashing loop indicator, then dial the 
extension again.

The loop indicator goes on steadily.

End of Procedure

Holding a call on a loop key
In some cases you may receive a call from someone who wishes to be 
transferred to several different extensions in turn. You can hold the call on a 
loop key so that the caller remains connected to your console when the called 
party hangs up.

Use Procedure 38 on page 110 to hold a call on a loop key.
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Procedure 38
Holding a call on a loop key

1 Dial the requested extension.

The Excl Src indicator in the Feature List goes on during dialing. You hear 
ringing. The Destination indicator flashes slowly.

2 Click the Hold button before or after the called party answers.

The loop indicator flashes slowly.

3 Click the Release button to free yourself to answer calls on other loop 
keys. The Release indicator goes on.

The called party answers.

The Destination indicator goes on steadily. The loop indicator continues 
to flash slowly.

4 When the called party hangs up, the Destination indicator goes off. Click 
the loop key beside the slowly flashing loop indicator to reenter the call. 

The loop indicator goes on steadily. The Destination indicator is off; you 
may extend the call to another party.

Note: When you only wish to put a call on hold, answer it, click the Hold 
button, and then Release.

End of Procedure

Call Park
Call Park enables you to put a call on hold without occupying a loop key on 
your console. You can, for example, hold a call on a Call Park extension while 
paging a called party.

Use Procedure 39 on page 111 to hold a call on Call Park extension while 
paging a called party.
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Procedure 39
Holding a call on Call Park extension 
while paging a called party

You wish to park a call, perhaps because the caller requests you to page 
someone. 

1 Click Park from the Feature List. 

The Park indicator in the Feature List goes on.

2 Do one of the following:

a.  If a Call Park extension is available, it is assigned to the call and 
displayed automatically. Make a note of the call and the Call Park 
extension. The Destination indicator flashes slowly.

b. Click the Release button. Page the called party and deliver the Call 
Park extension. (An unanswered parked call is returned to your 
console after a set time.) The Destination indicator goes off; the call 
is parked. The Release indicator goes on.

c. If no Call Park extension is available, nothing is displayed. Either take 
a message or place the call on Hold.

The Destination indicator flashes.

End of Procedure

Timed recall from an unanswered extended call
If a called extension does not answer within a set time (usually 30 seconds), 
the call is automatically returned to your console. The recall Incoming Call 
Indicator (ICI) goes on to signal this type of call.

Use Procedure 40 on page 112 to use timed recall from an unanswered 
extended call.
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Procedure 40
Using timed recall from an unanswered extended
call

1 You receive a timed recall from an unanswered extended call. Click the 
Loop key beside the flashing Source and slowly flashing Destination 
indicators. The tone stops and the Loop and Source indicators go on 
steadily; you are connected to the caller. You hear ringing at the called 
extension. The recall ICI is on.

2 Click the Rls Dst button. Ringing at the called extension stops. The 
Destination indicator goes off. 

3 Do one of the following:

a. If the caller does not wish to wait, click the Release button. The 
Release indicator goes on; you are free to process other calls.

b. If the caller wishes to wait, dial the extension again. (If the caller 
wishes to be transferred to another extension instead of waiting or 
calling back later, you can dial a new number now.) The Excl Src 
indicator in the Feature List goes on during dialing. The Destination 
indicator flashes slowly.

4 Click the Release button to end your connection in the call. The Release 
indicator goes on; you are free to process other calls.

End of Procedure

Timed recall from an unanswered parked call
A parked call, if unanswered, is returned to you after a set time.

Use Procedure 41 on page 113 to use time recall from an unanswered parked 
call. 
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Procedure 41
Using timed recall from an unanswered
parked call

1 You receive a timed recall from an unanswered parked call. Click the 
Loop key beside the flashing Source and slowly flashing Destination 
indicators. The tone stops and the Loop and Source indicators go on 
steadily; you are connected to the caller.The recall ICI, and call park 
indicators are on.

2 Do one of the following:

a. If the caller wishes to remain parked, click the Release button. The 
call is parked on the original call-park number. The Release indicator 
goes on; you are free to process other calls.

b. If the caller wishes to end the call, click the Rls Dst button, then the 
Release button. The call is unparked. The Source indicator goes off 
and the Release indicator goes on; you are free to process other 
calls.

End of Procedure

Recall from an extension using LINK or ATT RECALL
An extension user, while talking to someone on the phone, may recall you by 
clicking ATT RECALL, or by clicking LINK once and dialing your number, 
depending on the type of extension. The recall ICI goes on.

Use Procedure 42 to recall an extension using LINK or ATT RECALL. 

Procedure 42
Recalling an extension using LINK or
ATT RECALL

1 You receive a recall. Click the Loop key beside the quickly flashing 
Destination indicator. The tone stops and the Loop and Destination 
indicators go on steadily; you, the party originating the call, and the 
original caller are connected. The recall ICI and Source indicators go on.
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2 Click the Rls Dst button (if the recaller has not already released). The 
Destination indicator goes off; the recaller is disconnected.

3 If the caller wishes to be transferred, dial the new extension. The Excl Src 
indicator goes on during dialing. The Destination indicator flashes slowly.

4 Click the Release button to end your connection in the call. The Release 
indicator goes on; you are free to process other calls.

Note 1: This recall procedure describes a call that was originally 
extended through your console (Source and Destination indicators both 
active).

Note 2: If you wish to activate the Secrecy feature, which excludes the 
caller until connected to the called party, click Excl Src before extending 
the call. 

End of Procedure

Recall from an extension using Transfer
An extension user, while talking to someone on the phone, can recall you by 
clicking Transfer and dialing your number. The recall ICI goes on.

Use Procedure 43 to recall from an extension using Transfer.

Procedure 43
Recalling from an extension 
using Transfer

1 You receive a recall. click the Loop key beside the quickly flashing 
Source indicator. The tone stops and the Loop and Source indicators go 
on steadily; you and the recaller are connected. The recall ICI is on.

2 When the recaller clicks Transfer again, you and the original caller are 
connected. If the caller wishes to be transferred, dial the new extension. 
The Excl Src indicator goes on during dialing. The Destination indicator 
flashes slowly.

3 Click the Release button to end your connection in the call. The Release 
indicator goes on; you are free to process other calls. Recall from an 
extension using Conference.

End of Procedure
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Recall from an extension using Conference
An extension user, while talking to someone on the phone, can recall you by 
clicking Conference and dialing your number. The “0” ICI goes on.

Use Procedure 44 to recall from an extension using Conference.

Procedure 44
Recalling from an extension
using Conference

1 You receive a recall. click the Loop key beside the quickly flashing 
Source indicator. The tone stops and the loop and Source indicators go 
on steadily; you and the recaller are connected. The “0” ICI is on.

2 When the recaller clicks Conference again, you, the recaller, and the 
original caller are connected. If the original caller wishes to be transferred, 
dial the new extension. The Excl Src indicator goes on during dialing. The 
Destination indicator flashes slowly.

3 Click the Release button to end your connection in the call.

Note: This recall procedure describes a call that was not originally 
extended through your console (Source indicator active, Destination 
indicator off).

End of Procedure

Recall to Same Attendant
This feature functions the same way as normal call recall, with an 
enhancement. Previously, calls recalled to the first available attendant. With 
this feature enabled calls you extended can be queued to return to you only 
when you are idle. If you are busy, the calls remain in queue until you are 
available. The following are types of calls and recalls that can be queued to 
you for recall:

• Interattendant calls • Meter recalls
• Slow answer recalls • Park recalls

• Camp-On recalls • Call Waiting recalls
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Calling an extension
You can place a call to any extension within the system.

Use Procedure 45 to call an extension.

Procedure 45
Calling an extension

1 Click an idle Loop key. The loop indicator beside it goes on.

2 Dial the extension. You hear ringing. The Source indicator flashes slowly. 
When the called party answers, ringing stops and the Source indicator 
goes on steadily.

3 Click the Release button to end the call. The Release indicator goes on; 
you are free to process other calls.

End of Procedure

Calling an outside number
You can place a call to a number outside the system by dialing a trunk access 
code followed by the desired number.

Use Procedure 46 to call an outside number.

Procedure 46
Calling an outside number

1 Click an idle loop key.

The loop indicator beside it goes on.

2 Dial the required trunk access code. You hear dial tone.The Source 
indicator goes on.

3 Dial the outside number. You hear ringing. When the called party 
answers, ringing stops.

4 Click the Release button to end the call. The Release indicator goes on; 
you are free to process other calls.

End of Procedure
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Trunk-to-trunk call
A user, while outside the system, can call to request access to an outgoing 
trunk.

Use Procedure 47 to make a trunk-to-trunk call.

Procedure 47
Making a trunk-to-trunk call

1 You answer an incoming trunk call and the caller requests access to an 
outgoing trunk. Dial the trunk access code, then dial the requested 
number. 

The Excl Src indicator goes on during dialing. You hear dial tone after 
dialing the trunk access code, and ringing after the number. The 
Destination indicator goes on steadily. When the called party answers, 
you may talk privately. The Destination indicator remains on. The Excl Src 
indicator remains on.

2 Click the Release button to connect the calling and called parties. The 
Release indicator goes on; you are free to process calls on other loop 
keys.

Note: If neither of the trunks involved in the call has answer supervision, 
the call is automatically held on the loop key. When both parties hang up, 
the Source and Destination indicators remain on. Click the loop key and 
then Rls Src from the Feature List and Rls Dst and Release again. 

End of Procedure

Through-dialing
Extension or tie line users may request access to numbers or trunks which 
they are restricted from accessing themselves. Once you have accessed the 
trunk, the user is free to dial out. You can provide through-dialing to all but 
fully restricted extensions.

 Use Procedure 48 on page 118 to use through-dialing.
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Procedure 48
Using through-dialing

1 You receive a call from a restricted extension or tie trunk. Click the loop 
key beside the quickly flashing Source indicator. The tone stops. The loop 
key and Source indicators go on steadily. The appropriate ICI is on.

2 The caller requests access to a trunk. Dial the required trunk access code 
and listen for dial tone. The Excl Src indicator goes on during dialing. The 
Destination indicator is on steady. 

3 Do one of the following:

a. You can now complete the call by dialing the required number. Click 
the Release button to connect the call back to the restricted  user. The 
Release indicator goes on; you are free to process other calls.

b. After hearing dial tone, click the Release button to end your 
connection. The user can now dial the number. The Release indicator 
goes on; you are free to process other calls.

End of Procedure

Conference
You can set up a conference call for as many as six people, including yourself, 
at the request of either an extension user or an outside caller. A maximum of 
two trunks can be in the conference at one time.

Use Procedure 49 to set up a conference call.

Procedure 49
Setting up a conference call

1 Click an idle loop key and dial the number of the first conference party. 
The loop indicator goes on. You hear ringing. The Source indicator 
flashes slowly. When the first party answers, the Source indicator goes 
on steadily.

2 Dial the number of the next conference party. The Excl Src indicator goes 
on; the first party is automatically placed on hold while you dial. The 
Destination indicator flashes slowly. When the second party answers, 
the Destination indicator goes on steadily.

3 Click Conf. (Repeat steps 2 and 3 to add more parties to the conference.) 
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The Excl Src and Destination indicators go off; you and the first two 
conference parties are connected.

4 Do one of the following:

a. If you want to hold the conference at your console, click the Release 
button. The loop indicator flashes slowly. The Source indicator 
remains on. The Release indicator goes on; you are free to process 
other calls.

b. If you want to release the conference from your console, click the
Rls Src button, then the Release button. The loop indicators and 
Source indicators go off. The Release indicator goes on; you are free 
to process other calls.

Note: To reenter a conference that is being held at your console, click the 
loop key beside the flashing loop indicator. To end the conference call, 
click the loop key beside the flashing loop indicator, the Rls Src button, 
then the Release button. The console should be in normal mode when 
setting up a conference. 

End of Procedure

Calling another attendant
With this feature, you can call another attendant in your multiple-console 
group.

 Use Procedure 50 to call another attendant.

Procedure 50
Calling another attendant

1 Click an idle loop key.

The loop indicator goes on.

2 Dial the attendant access code.

3 Dial the appropriate attendant code. You hear ringing. The Source 
indicator flashes slowly.

4 The called attendant answers. click the Release button when you wish to 
end the call. Ringing stops. The Source indicator goes on steadily. The 
Release indicator goes on; you are free to process other calls.

Feature
List
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Note 1: If you dial an incorrect attendant code, you hear a fast busy 
signal and the Source indicator stays off. Click Rls Src.

Note 2: If the called attendant is busy, you hear ringback and the Source 
indicator flashes slowly. Continue to wait and your call will be the next call 
presented to that attendant. 

Note 3: If the called console is in position-busy or night-service mode, 
your call cannot be completed. You hear a fast busy signal and the 
Source indicator stays off. Click the Release button. 

End of Procedure

Transferring a call to another attendant
With this feature, you can transfer a call to another attendant in your 
multiple-console group.

Use Procedure 51 to transfer a call to another attendant.

Procedure 51
Transferring a call to
another attendant

1 The person to whom you are speaking wishes to speak to another 
attendant. Dial the attendant access code, then dial the appropriate 
attendant code. 

The Excl Src indicator goes on; the caller is automatically placed on hold. 
The Destination indicator flashes slowly. The Loop and Source indicators 
are on.

2 When the called attendant answers, click the Loop key. 

The Excl Src indicator goes off and the Destination indicator goes on 
steadily; you, the called attendant, and the caller are connected.

3 Click the Release button to end your connection in the call. The Release 
indicator goes on; you are free to process other calls If you dial an 
incorrect attendant code, you hear a fast busy signal and the Destination 
indicator stays off. Click the Rls Dst button.
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Note 1: If the called attendant is busy, you hear a busy signal and the 
Destination indicator continues to flash slowly. Click the Release button 
to transfer the call to the attendant’s queue.

Note 2: If the called console is in position-busy, you hear a busy signal 
and the Destination indicator flashes slowly. Click the Release button. 

End of Procedure

Break-in (post-dial)
You can interrupt an existing connection in order to offer a call or relay an 
important message to one of the parties.

Use Procedure 52 to use Break-in (post-dial).

Procedure 52
Using Break-in (post-dial)

Someone calls you and requests that you relay a message or extend the call 
to someone already on a call. 

1 Dial the requested extension. 

The loop key, ICI, and Source indicators go on steadily. The Destination 
indicator flashes, indicating that the extension is busy. The Excl Src 
indicator goes on steadily while you are dialing.

2 Click Break-In from the Feature List to interrupt the connection. If the 
extension is idle, the Break-In indicator goes off, and you hear ringing.

3 Do one of the following:

a. If the break-in is temporarily denied, you hear busy or fast busy tone, 
and the Break-In indicator flashes. Click the Rls Dst button. You can 
attempt a post-dial break-in after a few minutes or another pre-dial 
break-in immediately.

b. If break-in is denied completely, you hear a fast busy signal. Click the 
Rls Dst button.

4 You are in a three-way connection with the two parties in the established 
call. Relay the message, or announce the incoming call.

5 Do one of the following:

Feature
List
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a. Click the Excl Dst button to speak privately with the caller without 
ending the three-way connection.

b. Click the Release button to end the three-way connection and 
remain connected to the caller.

c. Click the Release button to end your connection in the call. The 
incoming call is camped-on if the called party is still busy, or extended 
if the called party’s extension is idle. The Release indicator goes on; 
you are free to process other calls.

Note 1: If the requested extension does not allow camp-on, the following 
can occur: 

• You hear a busy signal when you dial the extension. Refer to Step 1 
on page 121.

• The Destination indicator continues to flash when you click Break-In. 
Refer to Step 2 on page 121.

• You cannot extend the call or camp on to the extension. Refer to 
Step a. Click the Rls Dst button and redial the extension to extend 
the call.

Note 2: If the call is from an internal source, you cannot extend the call 
or camp on to the extension. Refer to Step b.

Note 3: Click the Rls Dst button and redial the extension to extend the 
call or camp on to the extension.

End of Procedure

Break-in (pre-dial)
You can interrupt an existing connection in order to offer a call or relay an 
important message to one of the parties. Use break-in (pre-dial) for extensions 
that have make set busy, do-not-disturb, hunting, or call forward activated.

Use Procedure 53 on page 123 to use Break-in (pre-dial).
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Procedure 53
Using break-in (pre-dial)

Someone calls you and requests that you relay a message or extend the call 
to someone already on a call.

1 Click Break In from the Feature List.

The Loop, Break In, ICI, and Source indicators go on steadily.

2 Dial the requested extension. The Excl Src indicator goes on steadily 
while you are dialing. The Destination Lamp indicator flashes, indicating 
that the extension is busy.

3 Click Break In in the Feature List to interrupt the connection. 

4 Do one of the following:

a. If the extension is busy, the Break In indicator goes off, and you hear 
ringing.

b. If the break-in is temporarily denied, you hear busy or fast busy tone, 
and the Break-In indicator flashes. Click the Rls Dst button. You can 
attempt a post-dial break-in after a few minutes or another pre-dial 
break-in immediately.

c. If break-in is denied completely, you hear a fast busy signal. click the 
Rls Dst button.

5 You are in a three-way connection with the two parties in the established 
call. Relay the message, or announce the incoming call.

6 Do one of the following:

a. Click Excl Dst to speak privately with the caller without ending the 
three-way connection.

b. Click the Release button to end the three-way connection and 
remain connected to the caller.

c.  Click the Release button to end your connection in the call. The 
incoming call is camped-on if the called party is still busy, or extended 
if the called party extension is idle. The Release indicator goes on; 
you are free to process other calls.

End of Procedure

Feature
List

Feature
List

Feature
List
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Break-in (busy verify)
You can check whether an extension is busy or idle before you attempt to 
break in.

Use Procedure 54 to use Break-in (busy-verify)

Procedure 54
Using Break-in (busy verify)

Someone calls you and requests that you relay a message or extend the call 
to someone already on a call.

1 Click an idle loop key.

The loop indicator goes on.

2 Click Break In from the Feature List.

The Break In indicator goes on.

3 Dial the extension you wish to check. If the DN is idle, you hear ringing, 
the loop indicator flashes slowly and the Break-In indicator goes off. Click 
Break-In to break in.

If the DN is disabled or unassigned, you hear a fast busy signal (overflow 
tone) and the loop key and Break-In indicators go off.

If the DN is busy, you hear a busy signal and the loop indicator flashes. 
Click Break-In to break in. 

If the DN is busy, the Break-In and loop indicators are steadily lit. You hear 
the intrusion tone. 

You are in a three-way connection with the parties in the established call. 
You can speak to the person on the extension.

4 Click the Release button to end your connection in the call. The Release 
indicator goes on; you are free to process other calls.

End of Procedure

Sending a warning tone to an extension in line lockout
When a handset is left off a telephone for an extended period of time, the 
telephone goes into a state called line lockout.

Feature
List
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Use Procedure 55 to send a warning tone to an extension in line lockout.

Procedure 55
Sending a warning tone
to an extension in line lockout

1 Click an idle loop key.

The loop indicator goes on.

2 Click Break In from the Feature List.

The Break In indicator from the Feature List goes on.

3 Dial the extension you wish to check.

A fast busy signal (overflow tone) is heard at the console.

4 To break in to the extension, click Break In from the Feature List.

The Break-In indicator from the Feature List goes off.

5 Click the Release button. 

The warning tone is sent to the extension.

Note 1: You cannot cancel the warning tone. It stops after a certain 
period of time, or when the telephone’s handset is put back on the hook.

Note 2: You cannot break in to an extension that is already receiving the 
warning tone.

End of Procedure

Requeueing a call to the next available attendant
You can requeue an incoming call or recall to the next available attendant.

 Use Procedure 56 on page 126 to request a call to the next available 
attendant.

Feature
List
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Procedure 56
Requeueing a call to the
next available attendant

1 You receive a call.

The ICI indicator goes on and the Source indicator flashes. The call is 
queued to the next available attendant.

2 If the system is in Night Service, the call is queued to the next available 
Night Service number.

End of Procedure

Timed Reminder Recall
Timed Reminder Recall calls you after a period of time to remind you that a 
transferred call has not yet been answered.

 Use Procedure 57 to use Timed Reminder Recall.

Procedure 57
Using Timed Reminder Recall

1 You receive a call for transfer. Dial the desired extension. 

The Destination Lamp winks.

2 Click the Release button before the extension answers. 

This starts the recall timer. If the extension answers the call, the timer 
stops.

3 If the extension does not answer, you receive a reminder call. 

The source lamp flashes and the destination lamp winks.

4 Click the Source key to connect with the calling party. If the dialed 
extension answers while you are on the line, a conference is established. 
You can then complete the transfer. If the called party does not answer, 
you can release the source call.

End of Procedure
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Centrex/Exchange Line Switchhook Flash
Centrex Switchhook Flash (THF) allows you to signal the Central Office 
during an established call to request activation of a Centrex service such as 
call transfer or three-way calling.

Use Procedure 58 to use Centrex/Exchange Line/Switchhook Flash.

Procedure 58
Using Centrex/Exchange
Line/Switchhook Flash

1 Click the Switchhook Flash key. 

You hear a special dial tone.

2 Click the DN before the tone ends. 

When you hang up, or click the Release button, the original connection 
and the THF message terminate.

End of Procedure

Remote Call Forward
 Use Procedure 59 to use Remote Call Forward.

Procedure 59
Using Remote Call Forward

1 Click an idle loop key followed by Attendant Remote Call Forward (RFW) 
in the Feature List.

The RFW key is flashing. The loop key is steadily lit.

2 Dial the DN of the set to be forwarded. 

If the password is required, the RFW key is winking, and the console 
display shows PWD. If the console does not support alpha characters, the 
attendant display will be blank.

If the password is not required, the console display will display the DN of 
the set to be forwarded followed by the CFW DN stored on that set. The 
RFW key lamp will display the status of the CFW DN. If RFW lamp is 
flashing, then CFW is not active; if RFW lamp is steady lit, then CFW is 
active. Proceed to step 4.
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3 Dial the password required followed by #.

The console display will display the DN of the set to be forwarded followed 
by the CFW DN stored on that set. The RFW key lamp will display the 
status of the CFW DN.   If RFW lamp is flashing, then CFW is not active; 
if RFW lamp is steadily lit, then CFW is active.

4 The user can now enter a new CFW DN or click the RFW key to activate 
or deactivate the stored CFW DN.

 If a new CFW DN is entered, it must be preceded by an RFW key click. 
The console display will display the DN of the set to be forwarded followed 
by the CFW DN. If RFW lamp is flashing, then CFW is not active; if RFW 
lamp is steadily lit, then CFW is active.

5 When the RCFW operation is in this state, the user has three options:

a. Click the Release button or the Rls Src key from the Feature List to 
complete RCFW operation.

b. Click the RFW key to reverse the CFW status.

c. Enter a new CFW DN to begin task of changing the CFW DN 
programmed. The new CFW DN is not active until the RFW key is 
clicked again.

6 Click the RFW key again to activate the CFW DN on the display.

If the DN entered is invalid, you hear overflow tone, and the FRW key 
indicator flashes. Reenter a valid DN.

7 Click the Release button.

This terminates the session. The DN is now forwarded.

End of Procedure

Call Forward/Hunt Override
 Use Procedure 60 to use Call Forward/Hunt Override.

Procedure 60
Using Call Forward/Hunt Override

1 Dial the FFC for Call Forward/Hunt Override.

2 Dial the DN of the wanted party.

— If the telephone is idle, the display(s) is updated.
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— If the display on the originating telephone is updated when the 
call is answered, the Call Forward/Hunt Override FFC will no 
longer display.

— If the dialed telephone is busy and Hunt is active, the calling 
party will terminate on the wanted telephone and will receive a 
busy signal.

— If the dialed telephone is idle but does not answer within the 
defined number of ringing cycles for Call Forward No Answer, 
the call is not forwarded (continues to ring).

— If the dialed telephone is busy, the attendant can activate 
Camp-On, if Camp-On is applicable. In addition, Ring Again can 
be placed against a telephone for which Call Forward/Hunt 
Override was used and a busy telephone was encountered.

End of Procedure

Attendant Console Autoline
Use Procedure 61 to place an Autoline call.

Procedure 61
Placing an Autoline call

1 Click an idle loop key.

The loop indicator is lit.

2 Click Autoline from the Feature List. The pre-programmed Autoline 
number is automatically dialed. The Source indicator winks.

The dialed party answers the call, and the Source indicator is steadily lit.

End of Procedure

Use Procedure 62 on page 130 to extend a currently active call to the Autoline 
DN.

Feature
List
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Procedure 62
Extending a currently active call
to the Autoline DN

1 Click Autoline from the Feature List. 

The pre-programmed Autoline number is automatically dialed. The 
Destination indicator winks.

The dialed party answers the call, and the Destination indicator is steadily 
lit.

2 To complete the transfer, click the Release button.

End of Procedure

Individual Attendant Directory Number (IADN)
Use Procedure 63 to answer an IADN call.

Procedure 63
Answering an IADN call

Click IADN from the ICI List. The first IADN call in the queue is answered.

End of Procedure

Attendant Emergency Codes
Use Procedure 64 to answer an emergency code call.

Procedure 64
Answering an emergency code call

1 You receive Priority Buzzing. Check the ICI List to see which type of 
emergency calls are indicated by lit ICIs.

2 Click the appropriate ICI key which designates the emergency. The call is 
answered, for example, Code Blue.

End of Procedure

Feature
List
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Recovery on Misoperation of Attendant Console
The Recovery on Misoperation of Attendant Console feature provides a 
safeguard on CS 1000 systems to prevent calls from being inadvertently 
disconnected.

Clicking the Release key or loop key is ignored when:

• Extending a call to a vacant number

• Extending to a partially dialed number

• Extending a Network blocked call

• Extending a call to a restricted station or trunk

• Extending to a station in the Do Not Disturb (DND) mode

• Extending to a station in the Make Set Busy (MSB) mode

• Extending to a maintenance busy station

• Extending to a station in a line lockout state

• Illegal call extension due to trunk barring

• Extending to a busy station with no Camp-on/Call Waiting

• Illegal call extension due to Trunk-to-Trunk Conference Restriction

• Illegal release from a conference connection 

Note: When using Autohold on the loop key, the active loop is 
automatically placed on hold if the attendant clicks another loop key 
prior to extending the active call. The Autohold key does not allow the 
disconnection of a single excluded party or conference call. If one of the 
parties on a loop is excluded, the operation of the corresponding Release 
Source Key or Release Destination Key is ignored.
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Features
Table 5 lists the Attendant PC features which are available for attendant 
operations, provided they are programmed in advance on the system 
switch.

Attendant Blocking of Directory Number

Use Procedure 65 on page 135 to block a DN.

Table 5
Attendant PC features

• Attendant Blocking of Directory 
Number

• Attendant Break-in Busy 
indication and prevention

• Attendant Monitor • Auto Dial

• Automatic Wake Up • Barge-In

• Busy Verify • Charge Account

• DID Route Conversion • Do-Not-Disturb

• End-to-end signaling • Enhanced Night Service

• Enhanced Secrecy • Malicious Call Trace

• Night Service • Paging 

•  Position Busy • Radio Paging

• Semi-Automatic Camp On • Series Call

• Speed Call • Speaking privately (Splitting)

•  Stored Number Redial • System Speed Call
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Procedure 65
Blocking a DN

1 The attendant clicks an idle loop key.

2 The attendant clicks Semi-automatic Camp-on (SACP) from the Feature 
List.

The SACP indicator goes on.

3 The attendant dials the source DN that is to be blocked. If the dialed DN 
is idle, the DN lamp will have the same state as a call put on hold, but the 
DN will not ring. If the DN is busy, the attendant hears busy tone and the 
SACP indicator darkens. 
If the dialed DN is idle, it is blocked. The DN lamp indicates a call on hold 
state, although the DN will not ring (for analog [500/2500-type] 
telephones, there is no indication that the DN is blocked.) On the 
Attendant Console, the SACP indicator remains lit and the Source 
indicator begins blinking.

If the dialed DN is busy, the attendant clicks the Release button or 
Rls Src to release the call.

End of Procedure

Use Procedure 66 to place an outgoing call for the blocked DN.

Procedure 66
Placing an outgoing call
for the blocked DN

1 The attendant establishes a call to the desired destination in the normal 
way.

2 The attendant clicks SACP (or Sig Src) from the Feature List. The 
ringback tone is heard.

3 If the source DN answers, the attendant clicks Release to extend the call 
between the destination to the source.

End of Procedure

Use Procedure 67 on page 136 to release a blocked DN.
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Procedure 67
Releasing a blocked DN

Choose one of the following:

a. The attendant clicks either SACP or Sig Src from the Feature List to 
ring the DN

b. The attendant clicks either the Release or Rls Src to release the 
source DN, which then becomes idle.

End of Procedure

Use Procedure 68 to notify a blocked DN of an established call.

Procedure 68
Notifying a blocked DN of an
established call

The attendant clicks SACP or Sig Src from the Feature List.

End of Procedure

Attendant Break-in Busy indication and prevention

If an attendant, during a break-in operation, dials a busy extension, the 
Attendant Console display provides one of the following customer-defined 
indications:

• three dashes, appended to the end of a digit display (if the busy station is 
involved in an external call), or

• a mode-digit, appended to the end of a digit display.

The operator can click on the break-in key either before or after dialing the 
destination DN. Break-In operates slightly differently in these two situations.

Attendant Monitor

The Attendant Monitor feature provides modifications to the Busy Verify and 
Barge-In features.
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Use Procedure 69 to monitor a DN.

Procedure 69
Monitoring a DN

1 Click on an idle loop key. The loop indicator is lit.

2 Click on Busy Verify in the Feature List. The Busy Verify lamp is lit.

3 Click on Busy Verify again to enable Attendant Monitor. The Busy Verify 
lamp is in the flashing state indicating that the Attendant Monitor option is 
enabled.

4 Dial the extension to be monitored. Attendant Monitor is blocked when: 

• the extension is busy or maintenance disabled

• the extension is vacant

• the extension is in some transient state (e.g., Conference or 
Transfer)

• the extension is idle, receiving busy tone, or receiving overflow tone

• the extension is involved with another attendant

• the extension has activated the Hold key

• the extension is already involved in a monitored call by another 
attendant

Attendant Monitor is active when the extension is busy. The attendant is 
able to listen to all connected parties. If the Attendant Monitor Customer 
Tone is denied (TOD), there is no indication given to the connected 
parties that the attendant is monitoring.

If the Attendant Monitor Customer Tone is allowed (TOA), a burst of tone 
is sent to the connected parties every 16 seconds. When the monitored 
DN disconnects from the call, Attendant Monitor is deactivated.
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5 Click the Release button to end Attendant Monitor. The Release lamp is 
lit, indicating that the attendant is now free to take other calls.

Deactivation occurs due to any one of the following:

• The Release button on the Attendant PC is clicked.

• Any DN involved in the monitored call is disconnected.

• Any DN involved in the monitored call at the customer location 
activated some form of call modification.

End of Procedure

Use Procedure 70 to monitor a Trunk.

Procedure 70
Monitoring a Trunk

1 Click on an idle loop key. 

The loop indicator lights.

2 Click on Barge-in from the Feature List. 

The Barge-in indicator lights.

3 Click on Barge-In again to enable the Attendant Monitor. 

The Barge-In indicator flashes indicating that the Attendant Monitor option 
is enabled.

4 Dial the trunk access code and route member number, then click on the 
pound key (#). One of the following occurs:

• Attendant Monitor is blocked when the trunk is disabled or idle.

• Attendant Monitor is blocked when the trunk is already being 
monitored by another attendant.

• Attendant Monitor is active when the trunk is busy. The attendant is 
able to listen to all parties on the trunk.

• If the Attendant Monitor Customer Tone is denied (TOD), there is no 
indication given to the connected parties that the attendant is 
monitoring.

• If the Attendant Monitor Customer Tone is allowed (TOA), a burst of 
tone is sent to the connected parties every 16 seconds.
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5 Click the Release button to end Attendant Monitor. 

The Release indicator lights, indicating that the attendant is free to take 
other calls.

Deactivation occurs due to any one of the following:

• The Release button on the Attendant PC is clicked.

• The trunk disconnects.

• Any party at the customer location performs some form of call 
modification or activates hold.

• Any party at the customer location disconnects.

• Any trunk involved in the monitored call disconnects.

End of Procedure

Auto Dial

After you have stored a number against an Auto Dial key, you can dial it by 
clicking on Auto Dial.

Use Procedure 71 to call a number using Auto Dial.

Procedure 71
Calling a number using Auto Dial

1 Click on an idle loop key. The loop indicator goes on.

2 Click on the required Auto Dial key. The Source indicator lights; the 
system automatically dials the stored extension.

Note 1: If you wish to display the extension stored for automatic dialing, 
click on Auto Dial, then click on Disp Src.

Note 2: You can store a number of up to 24 digits against an Auto Dial 
key. If you need to dial more than 24 digits, you can dial them after clicking 
on Auto Dial.

End of Procedure
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Storing an Auto Dial number

With Auto Dial, you can store a number (including access codes if necessary) 
against an Auto Dial key. You can also change a number already stored 
against an Auto Dial key.

Use Procedure 72 to store an Auto Dial number.

Procedure 72
Storing an Auto Dial number

1 When all loop indicators are off, click on Auto Dial. 

The Auto Dial indicator flashes.

2 Click on Disp Src. 

The display shows the number already stored for automatic dialing, if 
there is one.

3 Dial the number to be stored for automatic dialing. 

4 Click on the star key (*) after every trunk access code to ensure a pause 
for dial tone.

5 Click on Auto Dial again. 

The Auto Dial indicator goes off; the dialed extension is stored for 
automatic dialing.

End of Procedure

Automatic Wake Up

With Auto Wake-up, you can instruct the system to provide automatic 
wake-up calls at requested times. If extension numbers are not the same as 
room numbers, you must translate the room numbers into the corresponding 
extension numbers.

Use Procedure 73 on page 141 to program a wake-up call.
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Procedure 73
Programming a wake-up call

A hotel guest calls to request a wake-up call. 

1 Click Automatic Wake Up. 

If the displayed number is not the number requiring the wake up call, dial 
the proper number now.

The wake up indicator goes on. The ICI, loop, and Source indicators are 
on. The current wake-up time, if any, is displayed.

2 Click the pound key (#).

If the wake up indicator remains on steadily, the dialed number is valid. If 
it flashes, the number is invalid.

3 If the dialed number is valid, dial the requested wake-up time using a 
24-hour format.

If the wake up indicator remains on steadily, the requested wake-up time 
is acceptable. Go to Step 4.
If it flashes, the time is not acceptable. The next available time is 
displayed. Go to Step 5.

4 If the requested wake-up time is acceptable, click Automatic Wake Up 
again, then click the Release button.

The Release indicator goes on; you are free to process other calls.

5 If the initial request was not accepted, the next available time is displayed. 
Enter the new time, click Automatic Wake Up, then click the Release 
button.

The Release indicator goes on. You are free to process other calls.

Note: If the requested wake-up time is not acceptable to the system, the 
display shows alternative wake-up times in this order: 

• 5 minutes earlier than the requested time

• 5 minutes later than the requested time

• the first available 5-minute interval before the requested time

End of Procedure
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Canceling a wake-up call

You can cancel a wake-up call that has already been entered into system 
memory.

Use Procedure 74 to cancel a wake-up call.

Procedure 74
Cancelling a wake-up call

A hotel guest calls to request that a wake-up call be cancelled. 

1 Click Automatic Wake Up. (If the displayed number is not the number 
requiring cancellation of the wake up call, dial the proper number.)

The Automatic Wake Up indicator goes on.

2 Click the pound key (#), then click Automatic Wake Up again. (If the 
indicator flashes quickly, no wake-up call was found for the dialed 
number, click Automatic Wake Up again.)

The Automatic Wake Up indicator goes off; the wake-up request is 
canceled.

3 Click the Release button to end the procedure.

The Release indicator goes on; you are free to process other calls.

End of Procedure

Unanswered wake-up call notification

If a guest does not respond to the first wake-up call, the system makes up to 
two more attempts at 5-minute intervals. If the guest does not answer after the 
third call, the system, if option is set, notifies you of an unanswered wake-up 
call.

Use Procedure 75 to notify an unanswered wake-up call.
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Procedure 75
Notifying an unanswered wake-up call

A guest has not responded to three wake-up calls.

1 You hear a continuous buzz. The Automatic Wake Up indicator flashes 
quickly. The extension number of the room that has failed to respond is 
displayed.

2 To cancel the notification, click Automatic Wake Up.

The buzz stops. The Automatic Wake Up indicator goes off.

3 Click the Release button.

The Release indicator goes on; you are free to process other calls.

Note: When you are notified of an unanswered wake-up call, you may 
call the room again.

End of Procedure

Making a VIP wake-up call

At the requested time, you will provide a personal wake-up call to a guest 
with VIP status.

Use Procedure 76 to make a VIP wake-up call.

Procedure 76
Making a VIP wake-up call

1 A VIP wake-up call comes in to your console.

You hear a buzz and the Automatic Wake Up indicator fast flashes. The 
Display shows VIP.

2 Click an idle loop key, then click Automatic Wake Up.

You hear ringing, as the VIP’s room DN is dialled automatically. The 
Source indicator goes on, and Automatic Wake Up goes off.

3 If the guest does not answer or the DN is busy, click Release. 

The System will retry the VIP wake-up call in five minutes. 
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4 If the guest answers the VIP wake-up call, you deliver a personal wake-up 
message to the guest.

Click the Release button when you have finished the personal wake-up 
message.

Note: After a maximum of three attempts, if the guest still does not 
answer the VIP wake-up call, a message prints on the background 
terminal stating that the wake-up was tried, but unsuccessful.

End of Procedure

Barge-in

With Barge-In, you can verify that a trunk is in working order, or check the 
status of the trunk whether it is busy or idle.

Use Procedure 77 to use Barge-In.

Procedure 77
Using Barge-In

1 Click on an idle loop key. The loop indicator goes on.

2 Click Barge-In in the Feature List. The barge in indicator goes on.

3 Dial the required trunk access code and route member number, then click 
on the pound key (#). You hear a fast busy signal if the trunk is disabled 
or not assigned. You hear a fast busy signal and the Source indicator 
flashes if the trunk is blocked in the network. Attempt Barge-In again in a 
few minutes.

You are able to speak to all parties and the Source and Destination 
indicators go on steadily if the trunk is busy. Parties hear a warning tone 
every six seconds.

You hear dial tone, the Source indicator goes on steadily and the barge 
in indicator flashes if the trunk is idle.

4 Click the Release button to end the procedure. The Release indicator 
goes on, indicating that you can now take other calls.

Note: Barge-in cannot be used to verify the status of Release Link 
Trunks (RLT) used with Centralized Attendant Service (CAS).

End of Procedure
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Busy verify

With Busy Verify, you can verify that an extension is in working order, or 
check the status of an extension whether it is busy or idle.

Use Procedure 78 to use Busy Verify.

Procedure 78
Using Busy Verify

1 Click on an idle loop key. The loop indicator goes on.

2 Click Busy Verify in the Feature List. The Busy Verify indicator goes on.

3 Dial the extension you wish to check. You hear a fast busy signal if the 
extension is disabled or not assigned.

You are able to speak to all parties and the Source and Destination 
indicators go on steadily if the extension is busy. Parties hear a warning 
tone every six seconds.

The Source and Busy Verify indicators flash slowly if the extension is idle. 
The extension is not rung.

4 Click on Signal Source to ring the extension. If the called party answers, 
the Source and Busy Verify indicators go on steadily.

5 Click the Release button to end your connection in the call. 

The Release indicator goes on, indicating that you are now free to take 
other calls.

End of Procedure

Charge Account

You can assign a Charge Account number to an outgoing call after you have 
dialed the call.

Use Procedure 79 on page 146 to enter an account number after dialing a call.
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Procedure 79
Entering an account number
after dialing a call

You have dialed an outgoing call for an extension at your location. 

1 Click Charge.

The Destination indicator flashes; the called party is automatically placed 
on hold. The charge indicator goes on.

2 Dial the Charge Account number.

The Destination indicator goes off; the call is automatically reestablished. 
The charge indicator goes off.

3 Click the Release button to end your connection in the call.

The Release indicator goes on; you are free to process other calls.

Note 1: Charge account numbers may consist of up to 23 digits. The 
System ignores extra digits.

Note 2: You can also enter Charge Account numbers before extending 
incoming calls to extensions.

Note 3: During a Conference call, you can:

• assign portions of the call to different accounts by entering charge 
numbers as you add trunks to the conference

• assign the entire call to a single charge account number

End of Procedure

DID Route Conversion

Direct Inward Dialing (DID) permits incoming calls from outside lines that 
would normally be directed to the console to be routed to a preselected 
destination. Incoming DID digit conversion translates the digits that are 
actually dialed into digits that correspond to internal extensions. You can 
direct calls coming in on DID trunks to a set of extensions that are 
programmed as night destinations, or you can direct them to normal 
extensions.

Use Procedure 80 on page 147 to use DID Route Conversion.
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Procedure 80
Using DID Route Conversion

1 Click on an idle loop key. 

The loop indicator goes on.

2 Click on DID Route Conv. 

The DID Route Conv indicator goes on.

3 Click on the pound key (#) to see the status of all DID routes. 

The DID Route Conv indicator goes on steadily to show that all routes are 
in day mode. The DID Route Conv indicator flashes to show that some or 
all routes are in night mode.

4 Dial the route access code to see the status of a specific DID route.

The DID Route Conv indicator goes on steadily to show that the route is 
in day mode. The DID Route Conv. indicator flashes to show that the 
route is in night mode.

5 Click the Release button to cancel the change. All indicators go off. 
Nothing is changed.

6 Click on DID Route Conv to switch between day and night modes. 

All indicators go off. The mode of the DID route is changed.

Note 1: When you turn on Night Service, all DID routes automatically go 
into night mode. You can, however, switch individual DID routes into day 
mode.

Note 2: If you want to change all DID routes into night mode, and only 
some of the routes are in day mode, You have to first change all of the 
routes into day mode.

Note 3: If the DID route has been changed at a telephone (by the system 
administrator), you cannot change it at your console.

End of Procedure

Do-Not-Disturb

An extension in Do-Not-Disturb (DND) mode is free to place calls but 
appears busy to all incoming calls. You can put one extension or a predefined 
group of extensions into Do-Not-Disturb mode.
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Use Procedure 81 to set up Do-Not-Disturb mode.

Procedure 81
Setting up Do-Not-Disturb

1 Click on an idle loop key. 

The loop indicator goes on.

2 Click on Do-Not-Disturb in the Feature List. 

You can now set up individual or group DND. The Source indicator goes 
on. The Do-Not-Disturb indicator flashes slowly.

3 To set up individual DND, dial the extension requesting DND. 

4 To set up group DND, click on the pound key (#), then dial the appropriate 
group identification code, then click pound key (#) again. 

The Do-Not-Disturb indicator goes off (or goes on if the extension or 
group is already in DND mode).

5 Click on Do-Not-Disturb again. The Do-Not-Disturb indicator goes on; the 
dialed extension or group is now in DND.

6 Click the Release button to end the procedure. 

The loop, Source, and Do-Not-Disturb indicators go off. The Release 
indicator goes on.

Note: If you have a Do-Not-Disturb-Grp key, click on the 
Do-Not-Disturb-Grp key for the group of extensions you wish to place in 
do-not-disturb mode. The Do-Not-Disturb-Grp indicator flashes briefly, 
then goes on.

End of Procedure

Use Procedure 82 to use Do-Not-Disturb.

Procedure 82
Using Do-Not-Disturb

1 Click on an idle loop key. 

The loop indicator goes on.
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2 To test individual DND, dial the extension previously placed in DND 
mode. To test group DND, dial one extension within a group previously 
placed in DND. You hear a busy signal. The Source indicator flashes. The 
Do-Not-Disturb indicator in the Feature List goes on.

3 Click the Release button. 

The loop, Source, and Do-Not-Disturb indicators go off. The Release 
indicator goes on.

Cancelling Do-Not-Disturb

You can cancel Do-Not-Disturb (DND) for a single extension or for a 
predefined group of extensions.

Use Procedure 83 to cancel Do-Not-Disturb.

Procedure 83
Cancelling Do-Not-Disturb

1 Click on an idle loop key. 

The loop indicator goes on.

2 Click on Do-Not-Disturb in the Feature List. 

You can now cancel individual or group DND. The Source indicator goes 
on. The Do-Not-Disturb indicator flashes slowly.

3 Do one of the following:

a. To cancel individual DND, dial the extension to be removed from 
DND mode. 

b. To cancel group DND, click on the star key (#), dial the appropriate 
group identification code, and then click the star key (#) again. The 
Do-Not-Disturb indicator goes on. Click on Do-Not-Disturb again. 

The Do-Not-Disturb indicator goes off; the dialed extension or group is 
now removed from DND mode.



Page 150 of 270  Attendant PC features

553-3001-320 Standard 4.00 July 2006

4 Click the Release button to end the procedure. The loop and Source 
indicators go off. The Release indicator goes on.

Note: If you have Do-Not-Disturb-Grp keys, click on the 
Do-Not-Disturb-Grp key beside a Do-Not-Disturb-Grp indicator which is 
on, to cancel DND for that group. The Do-Not-Disturb-Grp indicator 
flashes briefly, then goes off.

End of Procedure

Overriding Do-Not-Disturb

A Do-Not-Disturb indicator which is on tells you that you have dialed an 
extension in Do-Not-Disturb mode. 

Use Procedure 84 to temporarily override DND for that call.

Procedure 84
Overriding Do-Not-Disturb

1 Click on an idle loop key. The loop indicator goes on.

2 Dial the extension previously placed in DND mode. 

You hear a busy signal. The Source indicator flashes. The Do-Not-Disturb 
indicator goes on.

3 Click on Do-Not-Disturb. 

You hear ringing. The Source indicator flashes slowly. The 
Do-Not-Disturb indicator goes off. The called party answers. 

4 Click the Release button when you wish to end the call. 

The Source indicator goes on steadily upon answer. The loop and Source 
indicators go off upon release. The Release indicator goes on.

Note: To override DND for an extension within a group that has been 
placed in Do-Not-Disturb, click on an idle loop key, click on the 
appropriate DND group key, then dial the extension as usual.

Testing Do-Not-Disturb

When the Do-Not-Disturb indicator goes on steadily, Do-Not-Disturb is 
functioning properly. 

Use Procedure 85 on page 151 to test Do-Not-Disturb.
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Procedure 85
Testing Do-Not-Disturb

1 Click on an idle loop key. 

The loop indicator goes on.

2 To test individual DND, dial the extension previously placed in DND 
mode. To test group DND, dial one extension within a group previously 
placed in DND. 

You hear a busy signal. The Source indicator flashes. The DND indicator 
goes on.

3 Click the Release button. 

The loop, Source, and Do Not Disturb indicators go off. The Release 
indicator goes on. A dnd. group indicator stays on steadily while the 
extensions within the group are in Do-Not-Disturb mode.

End of Procedure

End-to-end signaling

You can send Dual Tone Multiple Frequency (DTMF) signals from your 
console to access devices that require Touch tone signalling.

Use Procedure 86 to send DTMF signals.

Procedure 86
Sending DTMF signals

You have an active call on either the Source loop or Destination loop.

1 Click on EES. The EES indicator fast flashes.

2 Dial numbers on the dial pad. 

The connected party receives DTMF signals. Your line display may 
display each number you dial. You may hear the tones if feedback has 
been defined in software.
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3 Click on EES to end the procedure. The EES indicator goes off.

Note: The console can have only one party connected, either source or 
destination. Activating any feature that allows or requires an active party 
on the loop key (Hold, Call Park, Charge Account, Release) will cancel 
end-to-end signaling.

End of Procedure

Enhanced Night Service

Enhanced Night Service modifies the existing Night Service operation by 
allowing Public Network (Central Office [CO], Direct Inward Dial [DID], 
Foreign Exchange [FEX], and Wide Area Telephone Service [WATS]) 
trunks to be assigned to specific Directory Numbers (DN) during Night 
Service.

Enhanced Night Service allows you to:

• address different night answering requirements

• establish different patterns to satisfy required night, holiday, or weekend 
Night Service answering needs

• modify the assignment when Night Service is not active (a service 
change may also perform this modification)

Use Procedure 87 to determine the Night Service setting.

Procedure 87
Determining the Night Service setting

1 Click an idle loop key. 

The loop key indicator lights steadily.

2 Click the Busy button. 

The indicator flashes. You hear dial tone, and the current Night Service 
Option number is displayed.

3 Click the Release button. 

The loop and Busy indicators light steadily, and the display is cleared.

End of Procedure
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Use Procedure 88 to select a new Night Service.

Procedure 88
Selecting a new Night Service

1 Dial a one-digit (0 to 9) option number. 

The old Night Service number (X) is shifted and the new Option number 
(Y) is displayed. X and Y are separated by a hyphen, for example, Y-X.

2 Click the Release button. 

The Position Busy indicator goes out. The new Night Service option is 
stored. The display is cleared.

End of Procedure

Turning Enhanced Night Service on and off

Enhanced Night Service permits incoming calls that would normally be 
directed to the console to be routed to a preselected destination when the 
console is unattended. Your console may be equipped with either regular 
Night Service, or enhanced Night Service, but not both. If necessary, ask your 
system administrator which version of Night Service is on your console.

Use Procedure 89 to turn Enhanced Night Service on and off for a single 
console.

Procedure 89
Turning Enhanced Night Service on and off
for a single console

1 Click the Busy button to activate enhanced Night Service for a single 
console. 

2 Unplug the handset or headset. 

The current Night Service option number is displayed.

3 To cancel enhanced Night Service for a single console, plug in the 
handset or headset.

End of Procedure
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Use Procedure 90 to turn Enhanced Night Service on and off for multiple 
consoles.

Procedure 90
Turning Enhanced Night Service on and off
for a multiple consoles

1 Click on the Busy button at each console. 

2 Unplug all headsets and handsets. 

The current Night Service option number is displayed.

3 To cancel enhanced Night Service for multiple consoles, plug in at least 
one handset or headset.

When all consoles but one are in Position Busy mode and the attendant 
at the only active console clicks on the Busy key, the system is 
automatically placed in Night Service.

End of Procedure

Enhanced Secrecy

The Enhanced Secrecy feature ensures that either the caller or the called party 
is always excluded from the call when you are talking to the other party.

Use Procedure 91 to use Enhanced Secrecy.

Procedure 91
Using Enhanced Secrecy

1 Dial the requested extension. 

The Excl Src indicator goes on during dialing. You hear ringing. The LCD 
indicator flashes slowly.

When the called party answers, the Destination indicator goes on steadily. 
The caller cannot hear conversation between you and the called party. 

2 Click on the loop key beside the slowly flashing Source indicator to 
establish a three-way connection. You, the caller, and the called party 
hear a warning tone.

3 Click the Release button or an idle loop key to release the call from the 
console. 
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You cannot reenter the call. The caller and the called party remain 
connected. The Release indicator and all other indicators go off.

If you want to be able to reenter the call later, click on the Hold button, 
then the Release button. This step will exclude you from the call, but keep 
it on hold at the console. The caller and the called party remain 
connected. The loop key flashes slowly.

4 To reenter the call, possible only if you follow the process outlined in the 
second paragraph of step 3, click on the loop key beside the slowly 
flashing Source indicator. You, the caller, and the called party hear a 
warning tone.

Note 1: In Step 1, click on Excl Dst to talk to the caller while the called 
party’s extension is being rung. The called party is excluded from the 
connection when the call is answered. The caller hears ringing if you click 
on the Release button while the called party is being rung.

Note 2: In Step 2, there is no connection between the caller and the 
called party if either has warning-tone-denied Class of Service.

Note 3: To establish yourself, the caller, and the called party in a 
connection that allows the called party to make another call, click on 
Conference in the Feature List after Step 4.

End of Procedure

Malicious Call Trace

Malicious Call Trace lets you trace nuisance calls being presented to your 
console.

Use Procedure 92 to trace nuisance calls.

Procedure 92
Tracing nuisance calls

Click Call Trace from the Feature List while the call is in progress. 

The loop indicator is on. The Source or Destination indicator is on.

Note: A call trace report is printed on the maintenance terminal at your 
company. The report identifies the source or destination, or both.

End of Procedure



Page 156 of 270  Attendant PC features

553-3001-320 Standard 4.00 July 2006

Night Service

Night Service allows you to connect incoming trunks to selected Night 
Service extensions. You can assign any number of trunks to the same Night 
Service extension.

Use Procedure 93 to use Night Service.

Procedure 93
Using Night Service

1 Click on an idle loop key. 

2 Click the Busy key. 

You hear dial tone. The loop indicator goes on.

3 Dial the desired trunk access code and member number, followed by the 
pound key (#).

4 Click on Display Source to check the display. 

If the display is clear, no night-service extension has been assigned to the 
trunk. If the display shows an extension number, it is the night-service 
extension assigned to the trunk.

5 To set up a Night Service connection, dial the Night Service extension 
number to which the trunk is to be routed, followed by #.

6 To cancel an existing Night Service connection, press the star key (*), 
then the pound key (#). Trunk Answer From Any Station (TAFAS) is now 
allowed.

End of Procedure

Turning Night Service on and off

Night Service permits incoming calls that would normally be directed to the 
console to be routed to a preselected destination when the console is 
unattended. You can turn Night Service on or off for a single- or 
multiple-console System.

Use Procedure 94 on page 157 to turn Night Service on and off for a single 
console.
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Procedure 94
Turning Night Service on and off
for a single console

1 Click on the Busy button. 

2 Unplug the handset or headset.

3 To cancel Night Service for a single console, plug in the handset or 
headset.

End of Procedure

Use Procedure 95 to turn Night Service on and off for multiple consoles.

Procedure 95
Turning Night Service on and off
for multiple consoles

1 Click the Busy button at any console. 

2 Unplug all handsets and headsets.

3 To cancel Night Service for multiple consoles, plug in at least one handset 
or headset.

Note: When all consoles but one are in Position Busy mode and the 
attendant at the only active console clicks on the Busy key, the System is 
automatically placed in night-service mode.

Displaying and changing the Night Service option number

As part of enhanced Night Service, you can display and change the Night 
Service option number. The Night Service option number tells you which 
night number to which incoming calls will be directed.

Use Procedure 96 on page 158 to display the Night Service option number.
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Procedure 96
Displaying the Night Service
option number

1 Click on an idle loop key.

2 Click the Busy button. 

You hear dial tone. The loop indicator goes on.

End of Procedure

Use Procedure 97 to change the Night Service option number.

Procedure 97
Changing the Night Service 
option number

1 Dial a one-digit option number (0 to 9). 

The dial tone stops. The old and new Night Service option numbers, 
separated by a hyphen, are displayed. 

2 Click the Release button. 

The loop indicator goes off.

End of Procedure

Paging

You can page someone over your organization’s paging equipment through 
your console if the two are connected.

Use Procedure 98 to use Paging.

Procedure 98
Using Paging 

1 Click on an idle loop key. 

The loop indicator goes on.

2 Click on the Page key and make the announcement.
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3 Click the Release button to end the procedure. 

The loop indicator goes off. The Release indicator goes on, indicating that 
you are now free to take other calls.

End of Procedure

Position Busy

Position Busy allows you to make your console appear busy, thus preventing 
incoming calls from reaching you.

Use Procedure 99 to use Position Busy.

Procedure 99
Using Position Busy 

1 To activate Position Busy, click the Busy button when your console is idle 
(all loop indicators off).

 You will receive no further calls.

2 To cancel Position Busy, click the Busy button when your console is in 
Position Busy mode. 

You will now receive calls.

Note: In a single-console set-up, clicking on Busy places the System in 
Night Service. In a multiple-console setup, the System is placed in Night 
Service when all consoles are put into Position Busy.

End of Procedure

Radio Paging

Use Procedure 100 to use Automatic pre-selection.

Procedure 100
Using Automatic pre-selection

1 Lift handset. 

The telephone receives a dial tone.
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2 Enter the RPAC (FFC) for initiating RPA. 

The telephone receives the following:

• paging tone if FFC is valid

• CTVN treatment if FFC is invalid

• congestion tone (as configured) if no trunk is available in a single 
System

3 Enter the DN of the part to be paged.

The telephone receives the following:

• ringback tone, call progress tones or silence (as configured) if paging 
was successful

• no tone from the System if speech path is provided

• CTVN treatment if DN is invalid

• congestion tone if no paging trunk is available

• busy tone if absence signal is received

End of Procedure

Use Procedure 101 to use Automatic post-selection.

Procedure 101
Using Automatic post-selection

1 Lift the handset. 

The telephone receives a dial tone.

2 Enter the DN of the party to be paged. 

The telephone receives ringback or busy tone if DN is valid. It receives 
CTVN treatment if DN is invalid.
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3 Click on the RPAG key (for RPA). 

The telephone receives ringback tone, call progress tones or silence (as 
configured) if paging was successful. If the paging call recalls, the 
attendant can extend the call again.

• The telephone receives CTVN treatment if FFC or DN is invalid.

• The telephone receives congestion tone if no paging trunks are 
available.

• The telephone receives busy tone if absence signal is received.

End of Procedure

Use Procedure 102 to use Manual pre-selection.

Procedure 102
Using Manual pre-selection

1 Lift the handset. 

The telephone receives a dial tone.

2 Enter the RPAC (FFC) for initiating RPA. 

The telephone receives:

• paging tone if FFC is valid

• DTVN treatment if FFC is invalid

• congestion tone (as configured) if no paging trunk is available

3 Enter the DN of party you wish to reach. 

The telephone receives ringback or busy tone if DN is valid. The 
telephone receives CTVN treatment if DN is invalid.

4 Enter mode digit.

5 Enter information to be sent.
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6 Press the pound key (#). 

The telephone receives ringback tone, call progress tones or silence (as 
configured) if paging was successful.

The telephone receives busy tone if absence signal is received.

End of Procedure

Use Procedure 103 to use Manual post-selection.

Procedure 103
Using Manual post-selection

1 Lift the handset. 

The telephone receives a dial tone.

2 Enter the DN of the party to be paged. 

The telephone receives ringback or busy tone if DN is valid. The 
telephone receives CTVN treatment if DN is invalid.

3 Click on the RPAG key (for RPA). 

The telephone receives:

• ringback tone, call progress tones or silence (as configured) if paging 
was successful

• CTVN treatment if FFC or DN is invalid

• congestion tone if no paging trunks are available

End of Procedure

Semi-automatic Camp On

When an attendant extends a call to a desired party who is busy, the attendant 
can activate Semi-automatic Camp-On.

Use Procedure 104 on page 163 to activate Semi-automatic Camp-On.
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Procedure 104
Activating Semi-automatic Camp-On

1 Click Semi-automatic Camp-On in the Feature List. 

The call is camped on the desired party. The display shows the calling 
party’s DN, and the party to which the call is camped on (the desired 
party).

2 The desired party becomes idle. 

The call is recalled to the attendant. 

3 To ring the desired party after receiving the recall, click Semi-Automatic 
Camp-On in the Feature List again.

End of Procedure

Series Call

The attendant designates the source call as a Series Call by clicking Series 
Call (SECL) from the Feature List. Series Call may be clicked by the 
attendant while dialing, talking to the destination party, or while a call is 
ringing. The associated indicator remains lit until the Series Call is cancelled. 
If the attendant tries to extend a call to an external station, the SECL indicator 
flashes. The attendant has to click Series Call to cancel the Series Call, and 
extend the call as a standard call extension.

Speaking privately (Splitting)

Splitting allows you to talk to a called party without the caller hearing, or to 
talk to a caller without the called party hearing.

Use Procedure 105 to speak privately.

Procedure 105
Speaking privately

A caller requests an extension. 

1 To exclude the caller from the connection, click on Excl Src in the Feature 
List. 

The Excl Src indicator goes on.
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2 Dial the requested extension. 

The called party answers. Talk privately with the called party. You hear 
ringing but the caller does not. The Destination indicator flashes slowly. 
Upon answer, ringing stops and the LCD indicator goes on steadily.

3 To exclude the called party from the connection, click on Excl Dst. 

You and the caller are reconnected. Talk privately. The Excl Src indicator 
goes off. The Excl Dst indicator goes on.

4 To connect yourself, the caller, and the called party, click on the loop key. 
The Excl Dst indicator goes off.

5 To end your connection in the call, click the Release button. The Release 
indicator goes on, indicating that you are now free to take other calls.

Note 1: The Secrecy feature automatically prevents a voice connection 
between caller and called party while you are extending a call.

Note 2: Splitting allows you to talk selectively and privately to caller and 
called party while you are extending a call, or while you are actually 
connected to a call.

End of Procedure

Speed Call

If your console is designated a Speed Call user, you can place a call by dialing 
a one-, two-, or three-digit access code.

Use Procedure 106 to call a Speed Call number.

Procedure 106
Calling a Speed Call number

1 Click on an idle loop key. 

The loop indicator goes on.

2 Click on Speed Call.

3 Dial the one-, two-, or three-digit access code associated with the desired 
number. 

The Speed Call indicator goes off; the system automatically dials the full 
number.
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Note 1: After dialing the Speed Call code, you can add extra digits to the 
number represented by the code.

Note 2: If you wish to display the number stored against a speed-call 
access code, click on Disp Src after dialing the code.

End of Procedure

Storing a Speed Call number

If your console is designated a Speed Call controller, you can store a number 
for Speed Call and use the Speed Call codes. Also use this number-storing 
procedure to change a number stored against a Speed Call code.

Use Procedure 107 to store a Speed Call number.

Procedure 107
Storing a Speed Call number

1 When all loop indicators are off, click on Speed Call. 

The Speed Call indicator flashes.

2 Dial the one-, two-, or three-digit code to be associated with the phone 
number.

3 To see if a number is already associated with the dialed code, click on 
Disp Src from the Feature List. 

The current speed-call list entry (if any) is displayed.

4 Dial the number to be stored. Click on the star key (*) after every trunk 
access code to ensure a pause for dialtone.

5 Click on Speed Call again. 

The Speed Call indicator goes off; the access code and phone number 
you dialed are stored together for speed-calling.

6 To cancel a number stored against a code, click Speed Call, enter the 
code, and press the star key (*).
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Regarding Speed Call access codes:

• A one-digit access code (0 through 9) allows a Speed Call list of up 
to 10 numbers.

• A two-digit access code (00 through 99) allows a Speed Call slit of up 
to 100 numbers.

• A three-digit access code (000 through 999) allows a Speed Call list 
of up too 1000 numbers.

Note: The phone numbers assigned to Speed Call access codes can be 
4, 8, 12, 16, 20, 24, 28 or 31 digits long (including any asterisks inserted 
for dial-tone pauses).

End of Procedure

Stored Number Redial

Stored Number Redial (SNR) can be used when you hear either dial tone or 
special dial tone. This means that Stored Number Redial can be used during 
established calls to transfer or conference in a call.

Use Procedure 108 to use Stored Number Redial (SNR)

Procedure 108
Using SNR

1 Click on an idle loop key. 

The loop indicator goes on.

2 Click on Stored Number Redial to redial the stored number. 

The stored digits are automatically dialed.

3 Dial further digits now, if needed.

End of Procedure
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Use Procedure 109 to store an SNR number ahead of time.

Procedure 109
Storing an SNR number ahead of time

You can store one number of up to 31 digits for later use.

1 Click on Stored Number Redial. 

The Stored Number Redial indicator flashes.

2 Dial the number to be stored.

3 Click on Stored Number Redial again. 

The Stored Number Redial indicator goes off; the previously stored 
number is erased.

Note 1: If more than 31 digits are entered, you hear a dial tone.

Note 2: If SNR is clicked on and no digits (or more than 31 digits) are 
dialed, the SNR memory is not changed; the previously stored number 
remains unchanged.

Note 3: If SNR is not clicked on a second time, or the SNR sequence is 
interrupted by clicking on another key, the new entry is ignored; the 
previously stored number remains unchanged.

End of Procedure

Use Procedure 110 to store an SNR number during a call.

Procedure 110
Storing an SNR number during a call

You can use SNR while trying to establish a call (when the other end is ringing 
or busy), or during an established call (when you are talking to someone at the 
other end). If you are on an established call, go to Step 3. 

1 Click on an idle loop key. 

The loop indicator goes on.

2 Dial the required number.

3 Click on Stored Number Redial from the Feature List. 
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Note 1: When a call is active on the source and destination side, the 
destination number is stored. If only the source is active, no number is 
stored.

Note 2: For internal calls, the dialed digits must result in a busy signal or 
ringing. If insufficient digits or an invalid extension is dialed, the attempt to 
store the number is rejected and any previously stored number is not 
changed.

Note 3: For external calls, if no trunk is available, all digits dialed are 
stored even though some digits may be entered after an overflow or busy 
signal.

End of Procedure

System Speed Call

You can make a System Speed Call from a Meridian 1 proprietary telephone 
or an Attendant Console (user).

Use Procedure 111 to make a System Speed Call.

Procedure 111
Making a System Speed Call 

1 Click an idle loop key.

2 Click System Speed Call from the Feature List.

3 Dial the Speed Call code. 

If the Speed Call number is accepted, the telephone number represented 
by the Speed Call code is dialed automatically. No confirmation tone is 
given unless Flexible Feature Code (FFC) is implemented.

If the Speed Call number is not accepted, a fast busy signal indicates the 
number was rejected.

End of Procedure
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Features
This section defines the Attendant PC network features that are available 
for attendant operations. The network features described are divided into 
three groups:

• Centralized Attendant Service (CAS)

• Network Attendant Service (NAS)

• Networking (ESN, ISDN)

Centralized Attendant Service

With Centralized Attendant Service (CAS), attendant services for multiple 
locations can be provided from a single location. As a CAS attendant, you can 
handle calls that would normally be handled by the attendants at a remote 
location.

Use Procedure 112 on page 170 to answer a call to a remote console.
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Procedure 112
Answering a call to a remote console

You receive a call intended for a remote console. 

1 Click on the loop key beside the flashing Source indicator (or remote ICI) 
to answer the call. 

The tone stops and the loop and Source indicators go on steadily; you 
hear two beeps before you are connected to the caller. The remote ICI 
indicator is on.

2 Respond to the caller’s request. 

3 If no further action is needed, click the Release button to end the call.

The Release indicator goes on; you can now take other calls.

Note 1: Calls from remote locations travel over release line trunks 
(RLTs). Call source information consists of an RLT access code and 
member number.

Note 2: You can also receive direct calls from extension users and 
attendants at the remote location. Handle the same as for indirect calls 
outlined above, except that direct calls cannot be placed on silent hold. If 
you dial the silent hold code, you hear a fast busy signal.

End of Procedure

Extending a call to an idle extension

After answering a call to a remote console, you can extend it to the desired 
extension at the remote location.

Use Procedure 113 to extend a call to an idle extension.

Procedure 113
Extending a call to an idle extension

The caller requests an extension at the remote location. 

1 Click on the key that forwards calls from other sites to the main location. 

You hear dial tone from the remote location; the caller hears nothing. The 
remote ICI, loop, and Source indicators are on.

2 Dial the requested extension. 

You hear ringing at the remote location.
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3 If you wish to release before the called party answers, click the Release 
button. 

You are recalled if the called party does not answer within a set time after 
you release from the call. The Release indicator goes on; you can now 
take other calls.

If you wish to ensure that the called party is present, wait for an answer 
before releasing. When answered, the ringing stops; you can talk to the 
called party.

4 Once you have ensured that the called party is present, click the Release 
button to end your connection in the call.

End of Procedure

Extending a call to a busy remote extension

You can route one call to a busy extension at a remote location if camp-on is 
allowed at the busy end. If the called extension does not become idle within 
a set time, you are automatically recalled by the camped caller.

Use Procedure 114 to extend a call to a busy remote extension.

Procedure 114
Extending a call to a busy remote extension

The caller requests an extension at the remote location. 

1 Click on the key that forwards calls from a remote location to the main 
location. 

You hear dial tone from the remote location; the caller hears nothing. The 
remote ICI, loop, and Source indicators are on.

2 Dial the requested extension. 

If the called extension is busy, you hear a busy signal followed by a beep; 
you are reconnected to the caller.
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3 If the caller does not wish to wait, click the Rls Dst button, then the 
Release button to end the call. 

The Release indicator goes on; you can take other calls.

If the caller wishes to be camped on to the busy extension, click the 
Release button. If recall occurs, either click the Release button to 
reextend the call or click the Rls Dst button, then the Release button to 
end the call. The Release indicator goes on; you can take other calls.

Note: If you dial the requested number at the remote location and hear 
only a busy signal (with no beep), then a call is already camped onto that 
extension. If the caller wishes to wait, put the call on silent hold. 
Otherwise, release the call.

End of Procedure

Putting a call on silent hold

When one call is already camped onto a busy extension and a third caller 
wishes to wait for a connection, you can put the third caller on silent hold until 
camp-on becomes possible. You are automatically recalled by the caller after 
a set time.

Use Procedure 115 to put a call on silent hold.

Procedure 115
Putting a call on silent hold

The caller wishes to wait for a connection but cannot be camped onto the busy 
extension. 

1 Click on the key that forwards calls from a remote location to the main 
location. 

You hear dial tone from the remote location; the caller hears nothing. The 
remote ICI, loop, and Source indicators are on.

2 Dial the silent hold code. 

You hear four to six beeps.

3 Click the Release button to put the call on silent hold. 

The Release indicator goes on; you can take other calls.
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4 When recall occurs, check if camp-on is possible. If not, either put the call 
back on silent hold (Steps 2 and 3) or end it by clicking the Rls Dst button 
and then the Release button.

Note: When you place a call on silent hold, the release link trunk (RLT) 
is held at the remote location. When you use Hold, the RLT is held at your 
location.

End of Procedure

Remote recall

When you extend a call to an idle extension at a remote location and the called 
party does not answer within a set time, you are automatically recalled by the 
caller.

Use Procedure 116 to use remote recall.

Procedure 116
Using Remote recall

You receive a recall from a remote location. 

1 Click on the loop key beside the flashing Source indicator (or remote) to 
answer the call. 

The tone stops and the loop and Source indicators go on steadily; you 
hear a beep before being connected to the caller. The remote ICI indicator 
is on.

2 Click the Rls Dst button. Ringing at the called extension stops.

3 If the caller wishes to end the call, click the Release button. 

The Release indicator goes on; you can now take other calls.

If the caller wishes to speak to another party, dial the new number, then 
click the Release button. The Release indicator goes on; you can now 
take other calls.

Note: Recalls from remote locations travel over release link trunks 
(RLTs). Call source information consists of an RLT access code and 
member number.

End of Procedure
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Transferring a recall to another remote extension

A called party at a remote location can transfer a call back to you, which you 
can then extend to another extension.

Use Procedure 117 to transfer a recall to another remote extension.

Procedure 117
Transferring a recall to another
remote extension

You receive a recall from a remote location. 

1 Click on the loop key beside the flashing Source indicator (or remote) to 
answer the call. 

The tone stops and the loop and Source indicators go on steadily; you 
hear two beeps before you are connected to the called party. The remote 
ICI indicator is on.

2 The called party asks to have the caller transferred back to you. Click the 
Rls Dst button to release the called party from the call. 

You are connected to the caller.

3 If the caller wishes to end the call, click the Release button. 

The Release indicator goes on; you can now take other calls.

If the caller wishes to speak to another party, dial the new number, then 
click the Release button. The Release indicator goes on; you can now 
take other calls.

End of Procedure

Network Attendant Service

The following NAS features are processed the same as for local calls. 
You can find these features elsewhere in this section:

• Attendant Routing

• Break-In

• Call Extension

• Call Waiting
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• Camp-On

• Incoming Call Indication

• Night Service

• Off-Hook Queueing

• Timed Reminder Recalls

The next five features apply specifically to NAS situations. Clicking the NAS 
key on your screen console makes you available for calls from all locations 
in the network.

Answering a call from a remote console

With Network Attendant Service (NAS), attendant services for multiple 
locations can be provided from a single location. As a NAS attendant, you can 
handle calls that would normally be handled by the attendants at a remote 
location.

Use Procedure 118 to answer a call from a remote console.

Procedure 118
Answering a call from a remote console

You receive a call intended for a remote console. 

1 Click on the loop key beside the flashing remote ICI to answer the call. 
The tone stops and you are connected to the caller. The appropriate ICI 
indicator is on.

2 Respond to the caller’s request. If no further action is needed, click the 
Release button to end the call. The Release indicator goes on; you can 
now take other calls.

Note 1: Calls from remote locations travel over Integrated Service Digital 
Network (ISDN) trunks. Calling Line ID is supplied, to indicate the source 
of the call.

Note 2: You can also receive direct calls from extension users and 
attendants at the remote location. The procedure is the same as for 
indirect calls outline above, except that direct calls cannot be placed on 
silent hold. If you dial the silent hold code, you hear a fast busy signal.

End of Procedure
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Extending a call to a busy remote extension

You can route a call to a busy extension at a remote location if camp-on is 
allowed at the busy end. If the called extension does not become idle within 
a set time, you are automatically recalled by the camped caller.

Use Procedure 119 to extend a call to a busy remote extension.

Procedure 119
Extending a call to a busy remote extension

You receive a call intended for a remote console. 

1 Click on the loop key beside the flashing ICI key to answer the call. The 
appropriate ICI indicator is on.

2 The caller requests an extension at the remote location. Dial the 
requested location. 

The appropriate ICI indicators are on. If the called extension is busy, you 
hear a busy signal followed by a beep; you are reconnected to the caller.

3 If the caller does not wish to wait, click the Rls Dst button, then the 
Release button to end the call. 

The Release indicator goes on; you can now take other calls.

If the caller wishes to be camped onto the busy extension, click the 
Release button. If recall occurs, either click the Release button or click 
the Rls Dst button, then the Release button to end the call. The Release 
indicator goes on; you can take other calls.

Note: If you dial the requested number at the remote location and hear 
only a busy signal (with no beep), then a call is already camped onto that 
extension. If the caller wishes to wait, put the call on hold. Otherwise, 
release the call.

End of Procedure

Extending a call to an idle remote extension

After answering a call to a remote console, you can extend it to the desired 
extension at the remote location.

Use Procedure 120 on page 177 to extend a call to an idle remote extension.
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Procedure 120
Extending a call to an idle remote extension

You receive a call intended for a remote console. 

1 Click on the loop key beside the flashing ICI key to answer the call. The 
appropriate ICI indicator is on.

2 Dial the requested extension. 

You hear ringing at the remote location.

3 If you wish to release before the called party answers click the Release 
button. 

The Release indicator goes on; you can now take other calls.

To ensure that the called party is present, wait for an answer before 
releasing. When call is answered, the ringing stops; you can talk to the 
called party.

4 Once you have ensured that the called party is present, click the Release 
button to end your connection in the call. 

The caller and called party are connected. The Release indicator goes on; 
you can now take other calls.

End of Procedure

Remote recall

When you extend a call to an idle extension at a remote location and the called 
party does not answer within a set time, you are automatically recalled by the 
caller.

Use Procedure 121 to use Remote recall.

Procedure 121
Using Remote recall

You receive a recall from a remote location. 

1 Click on the loop key beside the flashing ICI indicator. 

The appropriate ICI indicator is on.

2 Click the Rls Dst button. The ringing at the called extension stops.
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3 If the caller wishes to end the call, click the Release button. 

The Release indicator goes on; you can now take other calls.

If the caller wishes to speak to another party, dial the new number, then 
click the Release button. The Release indicator goes on; you can now 
take other calls.

Note: Calling Line ID supplies the information regarding the source of the 
recall.

End of Procedure

Transferring a call to another remote extension

A called party at a remote location can transfer a call back to you, which you 
can then extend to another extension.

Use Procedure 122 to transfer a call to another remote extension.

Procedure 122
Transferring a call to another remote extension

You receive a call from a remote location. 

1 Click on the loop key beside the flashing ICI indicator to answer the call. 

The appropriate ICI indicator is on.

2 The called party asks to have the caller transferred back to you. Click the 
Rls Dst button to release the called party from the call. You are connected 
to the caller.

3 If the caller wishes to end the call, click the Release button. 

The Release indicator goes on; you can now take other calls.

If the caller wishes to speak to another party, dial the new number, then 
click the Release button. The Release indicator goes on; you can now 
take other calls.

End of Procedure

Networking (ESN, ISDN) features

When an extension user requests an ESN location, you may have to enter an 
authorization code to override the access restrictions assigned to the user’s 
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extension. Authorization codes are issued to extension users with special 
calling needs.

Use Procedure 123 on page 179 to override access restrictions.

Procedure 123
Overriding access restrictions

A caller requests an extension at a distant ESN location and provides an 
authorization code. 

1 Dial the requested number. The Excl Src indicator goes on. You may hear 
the authorization-code prompt:

• a recorded message followed by three beeps, or 

• ten beeps followed by dial tone

2 Dial the user’s authorization code. The call is completed.

3 Click the Release button to end your connection in the call. 

The Release indicator goes on; you can now take other calls.

End of Procedure

Charge Account

If your console has a Charge key, you can assign a charge account number to 
a call about to be extended to an ESN location.

Use Procedure 124 to assign a charge account number to a call.

Procedure 124
Assigning a charge account number
to a call

A caller requests an extension at a distant ESN location and wishes to charge 
the call to an account number. 

1 Click on Charge. 

The Charge indicator goes on. The Destination indicator flashes.

2 Dial the charge account code. 

The Charge and Destination indicators go off when the last digit of the 
charge account code is entered.
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3 Dial the call as usual and click the Release button. 

A charge record is produced when the trunk is accessed. The Release 
indicator goes on; you can now take other calls.

End of Procedure

Expensive Route Warning Tone

When an extension user requests an ESN location, you may be signaled that 
only an expensive route is available. The caller can accept the expensive route 
(direct distance dialing, or DDD) or try again later.

Use Procedure 125 to accept or reject an expensive route.

Procedure 125
Accepting or rejecting an
expensive route

A caller requests an extension at a distant ESN location. 

1 Dial the requested number. 

The Exsl Src indicator goes lights. You hear three beeps if the only 
available route is the most expensive one.

2 Do one of the following:

a. To accept the expensive route, company policy permitting, stay on 
the line. The call is completed.

b. To reject the expensive route, click the Release button. The Excl Src 
indicator goes off; you and the caller are reconnected.

3 Click the Release button to end your connection in the call. 

The Release indicator goes on; you can now take other calls.

End of Procedure
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Extending a call — off-hook queueing

When an extension user requests an ESN location for which a trunk is not 
immediately available, you can:

• wait off-hook until a trunk becomes available

• release the connection and allow the caller to wait for the trunk

Use Procedure 126 to use off-hook queueing.

Procedure 126
Using off-hook queueing

A caller requests an extension at a distant ESN location. 

1 Dial the requested number. 

The Excl Src indicator goes on during dialing. you hear a beep if a route 
is not immediately available.

2 Inform the caller that there will be a brief wait.

3 Click the Release button to end your connection in the call. 

The Release indicator goes on; you can now take other calls.

End of Procedure

Network Speed Call

With Network Speed Call, you can extend calls to a selected number at an 
ESN location by dialing a one-, two-, or three-digit code.

Use Procedure 127 to use Network Speed Call.

Procedure 127
Using Network Speed Call

1 Click on a loop key. 

The loop indicator goes on steadily.
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2 Dial the network access code, the Network Speed Call list access 
number, and the one- to three-digit code for the desired number. 

The Source indicator goes on steadily. The number is automatically 
dialed.

End of Procedure

Routing control

You can use ESN routing control to modify extension user’s network access. 
When routing control is on, each extension usually has more restrictions. 
Turning routing control off restores the Network Class of Service (NCOS) 
assigned to each ESN user.

Use Procedure 128 to use routing control.

Procedure 128
Using routing control

1 To turn routing control on, click on Routing Controls in the Feature List.

The Routing Controls indicator goes on.

2 To cancel routing control, click on Routing Controls. 

The Routing Controls indicator goes off.

End of Procedure
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Using the Attendant PC Help Facility
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Description
Online Help is essential to learning and using the Attendant PC. There are two 
kinds of Help: Help about a specific procedure and Help that gives you 
information about what you see on your screen.

About the Help facility
The Help facility provides the following three functions:

• describes the toolbar menu and console keys, such as fixed keys, loop 
keys and lamps

• provides definitions of call processing features, such as Barge In, Call 
Waiting, Call Park, and Malicious Call Trace

• gives setup instructions for feature keys, trunk group busy keys (TGB), 
and incoming call indication (ICI) keys.
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The Help menu
This section describes the Help facility and the options you can access to 
select Attendant PC topics of interest ranging from “Creating a Virtual 
Feature” to understanding basic loop key operation. The next section 
provides examples of object and topical information contained within the 
Help facility. 

Select a Help menu on your Console screen from the following options:

You can also access Help for a dialog box object by using any of the 
following means:

— Click the right mouse button on a Attendant PC object to display 
a “What’s This?” message

— Click the icon in the dialog box title bar to display a Help 
cursor, then click the object

— Press the  key to get Help on the selected object

— Use the  key to close the current Help window.

Console Help F1

When you press the  function key on your keyboard, your terminal 
displays the Help Console window shown in Figure 62.

This window contains an image of your console, including its menu, and also 
has its own four-item menu bar displayed at the top:

The Help topics menu bar contains the following selections:

F1

Esc

F1
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— Help Topics

— Back

— Options

— Glossary

Figure 62
Console Help window 

Contents tab 

Use the Contents tab from Help Topics to assist you in finding Attendant PC 
information quickly (Figure 63) to provide step-by-step procedures as well as 
set up instructions for “Using the PC console screen”, for example:

— Building an attendant’s toolbox

— Extending a call to voice mail

— Adding an attendant 

— Headset and handset operation

— Sizing a PC console screen

Help Topics menu bar

Contents
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Figure 63
Contents tab window

Index tab

Use the Index tab to search console keywords for Help on a specific topic. The 
Index serves as a traditional book index, listing keywords and phrases 
alphabetically.

See Figure 64 on page 187.

Represents a category

Reveals book contents

A page represents

of topics

an individual topic

Some Help topics contain
Tip

green underlined text.
You can click the green text
to see a definition of the term.

Index
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Figure 64
Index tab window

Find tab

Use the Find tab to initiate a full-text search for any Attendant PC keyword 
or phrase in the Help facility.

See Figure 65 on page 188. 

Double click on a console
topic or click the Display
button.

To scroll through the Help
Index, type the first few
letters of the word you want to
search for.

Tip

To return to the list of
topics, click Help Topics.
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Figure 65
Find tab window

Options menu

Use the Options menu to access enhanced console Help functions. The menu 
contains the following selections:

— Annotate - Allows you to add notes to a topic.

— Copy - Allows you to copy all or some selected topic text.

— Print Topic - Allows you to print selected topic.

— Keep Help on Top - Allows the Help window on top, or in a 
default position.

— Font - Allows you to specify small, normal or large font.

— Use System Colors - Allows you to display the Help system 
using specified colors. 

Find

Type the keyword or phrase
you want to find.

Double click on a console
topic or click the Display
button.

Tip

To return to the list of
topics, click Help Topics.

Annotate

Copy
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Glossary descriptions of console features

The Glossary window (Figure 66) provides a reference for reading about 
console features. Click on any Attendant PC entry of interest to display a 
popup description for that feature.

Figure 66
Glossary window

About the Attendant PC software

This Help menu displays the current software version of the Attendant PC 
application that you are presently using, for example; Version 1.1. Copyright 
® 1996-1997, Nortel. All rights reserved.”.

Note: Not every feature is available on every Attendant PC application. 
Features available for the release of software on your System are 
described in the NTP Features and Services (553-3001-306).
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Installing the Attendant PC Software
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Overview
This section provides instructions for installing the Attendant PC software 
application. 

Note: After you have completed the software installation that follows, 
refer to “Installing the PC Console Interface Unit” on page 222 and 
follow the procedures that describe how to install the PC Console 
Interface Unit (PCCIU).

System requirements
To use the Attendant PC software application, you need the following 
equipment:

• PC compatible computer system containing:

— Pentium processor, 100 MHz or higher

— 16 MB RAM available memory

— Hard disk with at least 10 MB of free disk space

— 17” SVGA color monitor (1024 by 768 resolution, 256 colors)

— 16-bit sound board (recommended)

— Printer (optional) 

— Network interface adapter (for LAN applications)

— Windows 95®, Windows 98®, Windows 2000® , Windows NT® 
or Windows XP® operating systems

— RS232 serial port
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Installing the software
Note: Before you set up the Attendant PC software turn off any virus 
protection programs you may have running. Virus protection programs 
can interfere with the set up process.

The disk set in your package includes an InstallShield Wizard to help you 
quickly install your copy of the Attendant PC software.

Use Procedure 129 to install the Attendant PC software.

Procedure 129
Installing the Attendant PC software

1 Make sure that no applications are running.

2 Make a written note of the serial number printed on the disks. This number 
will be requested later during the installation.

3 Insert disk 1 into the drive from which you want to install.

4 Double-click the My Computer icon on your Windows desktop.

5 Double-click the Control Panel icon shown in Figure 67.

The “Control Panel” dialog window displays.

6 Double-click on Add/Remove Programs icon shown in Figure 67 on 
page 194.
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Figure 67
Accessing the Add/Remove Programs Control Panel

The Install/Uninstall property page from the Add/Remove Program Properties 
sheet is displayed.

Figure 68 on page 195 shows the Install/Uninstall property page.
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Figure 68
Install/Uninstall property page
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7 Click Install.

Figure 69 shows the Install Program from Floppy Disk window. 

Figure 69
Install Program from Floppy Disk window
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8 Click Next.

Figure 70 shows the Run Installation Program window.

Figure 70
Run Installation Program window

9 Click Finish. 

The Attendant PC Console setup prepares the “InstallShield Wizard” to 
assist you in the set up process.
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The next window displays the software license agreement. Before you 
click YES, make sure you read carefully all of the terms of the license 
agreement.

Figure 71 shows the Software license agreement window.

Figure 71
Software license agreement
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The installation process continues with the Welcome display.

Figure 72 shows the Welcome display window.

Figure 72
Welcome display
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10 Click Next to display the User Information window.

11 Enter your name and company and click Next.

Figure 73 shows the User Information window.

Figure 73
User information display

The “Setup Type” window prompts you to indicate the setup you 
prefer for the Attendant PC console (Figure 74). 

12 Choose “Standalone”, or, if you will be connecting more than one 
attendant together via a LAN, choose “Network - Initial” or “Network - 
Additional Workstation” as appropriate. See “Installing the LAN Interface 
Software” on page 235 for more information.

13 Click Next to continue.

Figure 74 shows the Setup type window.
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Figure 74
Setup type

14 Click Next to choose the Destination Folder of the Attendant PC, or 
browse to select another folder.

Figure 75 on page 202 shows the Choose Destination Location window.
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Figure 75
Choose Destination Location window
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15 When the Select Program Folder window appears, click Next to continue. 

Figure 76 shows the Select Program Folder window.

Figure 76
Select Program Folder window
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16 When the “Start Copying Files” window appears, click Next to continue. 

Figure 77 shows the Start Copying Files window.

Figure 77
Start Copying Files window
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17 When prompted, insert the Attendant PC disk 2 or disk 3 into drive A:\ and 
click OK.

Figure 78 shows the Next disk display window.

Figure 78
Next disk display

A status gauge reports the final copying progress of the set up program.
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After a short time, the Setup Complete window displays (Figure 79) 
indicating that the Attendant PC software installation has succeeded.

Figure 79 shows the Setup complete window.

Figure 79
Setup complete display
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18 Click Finish to restart your computer.

Now that your Attendant PC software is installed, you may wish to create 
a shortcut “console icon” to display on your desktop, to allow you easy 
access to the application.

See your Windows User Guide or online Windows Help to assist you in 
creating a shortcut.

19 Once you’ve created your shortcut, double click on it to register your serial 
number and console name (Figure 80).

20 Enter the serial number that is printed on the diskette label into the “Serial 
Number” box.

21 In the “Console Identification” box, enter text which readily identifies the 
console to the users of the Attendant PC system.

For example:

“Reception Area - East Wing” or “Reception Area - Main Lobby”

This information will be displayed on the top status bar after the word 
“Console.”
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22 Enter the serial number found on the installation diskettes, then click OK 
to confirm your serial number is correct and launch the Attendant PC 
console.

Note: Entering the serial number is not the same as registering the 
software. Please refer to “Registering the Attendant PC software” on 
page 210.

Figure 80 shows the Attendant PC Serial number window

Figure 80
Attendant PC Serial number

The Main Screen appears. This is the screen that the attendant will use 
to perform basic call processing functions and use features.

Figure 81 on page 209 shows the Attendant PC Main Screen window.
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Figure 81
Attendant PC Main Screen

When the Main Screen appears, the Attendant PC will be in position busy 
or night and must be removed from that state before it can receive calls.

End of Procedure
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Registering the Attendant PC software
The Attendant PC software has now been installed, however this software 
will expire in 30 days unless it is made permanent by the following 
registration process. 

Note: If the Attendant PC software has not been registered within 30 
days after installation, you will be unable to access the application and 
you will be prompted to enter a registration number before you can use 
the software. 

Note: Completing registration before the 30 day period ends is highly 
recommended, since some information, such as the “Installation code”, 
which is requested when you are obtaining the registration code through 
the registration process, is available only within the Attendant PC 
application.

Use Procedure 130 to register your copy of Attendant PC software.

Procedure 130
Registering your copy of
Attendant PC software

1 Choose Console Configuration from the Configuration menu, then 
click the Consoles tab.

2 Click the Register tab.

3 Call the number provided on the dialog box and provide the information 
requested by the technical staff.

4 Type the registration number provided by the technical staff into the text 
box and click OK.

End of Procedure
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Configuring voicemail
Before the attendant can extend calls to voice mail, the voice mail access 
number must be configured in the Attendant PC.

Use Procedure 131 to configure voicemail.

Procedure 131
Configuring voicemail

1 Choose Console Configuration from the Configuration menu, then 
click the General tab.

2 Enter the access number for voicemail in the appropriate text box.

3 Enter the voicemail number termination flag in the appropriate text box.

4 Click the General tab.

5 Select a default WAV file for audible signalling (optional).

6 Select the length of time delay (in milliseconds) when a comma is 
encountered during dialing.

7 Click the Flex Keys tab.

8 Assign End to End Signalling (EES) to a Flexible Feature key.

9 Click OK to return to the main screen.

The Voicemail icon now appears on the Main Screen to the right of the 
Directory icon.

End of Procedure
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Programming a Call Park Virtual Feature
Before the attendant can activate the Call Park feature, it must be 
programmed as a Virtual Feature. 

Use Procedure 132 to create a Virtual Feature for Call Park.

Procedure 132
Creating a Virtual Feature for
Call Park

1 Select Console Configuration from the Configuration menu.

2 Click the Features tab.

3 Click New.

4 Enter the “Feature Description” and “Key Label.”

Figure 82 shows the Feature Specification window.

Figure 82
Feature Specification window

5 Make sure that the Virtual radio button is selected in the Type box.

6 Click Processing.
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7 Select each of the following steps in the left column and click Add:

• Dial a number (Dynamic)

• Press Release

Figure 83 shows the Call Park - Processing Procedure window.

Figure 83
Call Park - Processing Procedure window 

8 Click OK until you return to the Main Screen.

The Call Park Virtual Feature will appear in the Feature List with the name 
you entered as the “Key Label.” Virtual Features are distinguished by light 
blue icons.

Now you can activate the Call Park Virtual Feature by clicking it from the 
Feature List and entering the extension where the call will be parked.

End of Procedure
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Accessing the CPLUS Directory
Procedure 133 shows you how to use the CPLUS Directory function to 
upload CPLUSDIR.BTR dialing numbers from a diskette to the Attendant PC 
Data folder. These dialing numbers can then be transferred to your personal 
Directory.

Use Procedure 133 to use CPLUS Directory to upload CPLUSDIR.BTR.

Procedure 133
Use CPLUS Directory to upload CPLUSDIR.BTR

1 Select CPLUS Directory from the Tools menu.

A dialog displays prompting you that the CPLUS directory file 
CPLUSDIR.BTR cannot be found.

Figure 84 shows the CPLUS Directory dialog box.

Figure 84
CPLUS Directory dialog box

2 Click Yes to locate the CPLUS file.

The CPLUS Directory “Look in” window is displayed.

3 Click the  to display the 31/2 Floppy (A:) drive icon.

Figure 85 on page 215 shows the CPLUS Directory Look in window.
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Figure 85
CPLU Directory Look in display window

4 Select the CPLUSDIR.BTR file and click Open.

The CPLUSDIR.BTR file is uploaded to the Attendant PC Data folder.

Figure 86 on page 215 shows a view of a console desktop with populated 
Toolbox and Directory windows. All features, ICIs, and TGBs are now 
easily accessible in one central location.

Click here to 
access the 
drop-down
devices window.
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Figure 86
Customized Toolbox display

End of Procedure

ToolboxDirectory
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Changing database location
The default database and configuration files reside in the Data folder within 
the Attendant PC folder. 

In the event of a network failure, the directory information on the network 
will be unavailable to the attendant. For this reason, attendants should 
periodically copy the network database files to the Data folder in the 
Attendant PC folder on their hard drive.

Use Procedure 134 to back up the network database files to another location.

Procedure 134
Backing up network database files
to another location

1 Locate the Data folder located on the network.

2 Double click the folder.

Three files are displayed: Config.dat, Directory.dat, and Information.dat.

3 Press Ctrl + A to select all three files.

4 Press Ctrl + C to copy the three files.

5 Locate and double click the Data folder within the Attendant PC folder on 
your hard drive (C: drive).

6 Press Ctrl + V to paste the three files into the Data folder on your hard 
drive.

Frequent copying of these files from the network to the local hard drive will 
ensure that the local directory files contains accurate directory 
information.

End of Procedure

Use Procedure 135 on page 218 to configure the Attendant PC to use the 
directory information on your hard drive rather than the network directory 
information. 
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Procedure 135
Configuring the Attendant PC to use 
directory information on the hard drive

1 Click on the Configuration menu and select Change Database 
Location.

2 Select the Config.dat file located in the Data folder in the Attendant PC 
folder on the hard drive (C: drive).

3 Click Open.

The Attendant PC software restarts and accesses the directory 
information on your hard drive.

When the network becomes operational, you should perform the Change 
Database Location command again to access the network directory 
information:

4 Click on the Configuration menu and select Change Database 
Location.

5 Select the Config.dat file located in the Data folder on the network.

6 Click Open.

The Attendant PC software restarts and accesses the network directory 
information.

End of Procedure
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Exporting Directory numbers
Use Procedure 135 to export Directory numbers.

Procedure 136
Exporting Directory numbers

1 Click Directory to select Export.

Figure 87 shows the Export display window.

Figure 87
Export display window

2 Click New to enter a name for the new export job.

The Export Job window displays.

Figure 88 on page 220 shows the Export Job display window.

Click Edit (Figure 24) to modify file
information and columns for the exported

Click Delete to remove an export
 directory job.

directory job.Click the Help button to 
see information on 
Exporting jobs using the 
Contents, Index, and 
Find tabs.

Tip
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Figure 88
Export Job display window

3 Click OK.

End of Procedure

Importing Directory dialing numbers
Use Procedure 137 to import Directory sources.

Procedure 137
Importing Directory sources

1 Click Directory to select Import.

Figure 89 on page 221 shows the Import display window.

Double click on a 
column item to move it 
quickly between “not 
displayed” to 
“displayed” areas.

Tip

Indicate File Information (default is 
Comma Separated) and Output File 
Name or location of the export job.

Select the columns you want 
included in the export file.
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Figure 89
Import display window

2 Click New to enter a name for the new import job.

The Import Job window displays.

Figure 90 shows the Import Job display window.

Figure 90
Import Job display window.

3 Click OK.

End of Procedure

Click Edit (Figure 24) to modify file
information and columns for the imported

Click Delete to remove an import
 directory job.

directory job.
Click the Help button to 
see information on 
Importing jobs using 
the Contents, Index, 
and Find tabs.

Tip

Double click on a 
column item to move it 
quickly between “not 
displayed” to 
“displayed” areas.

Tip
Indicate File Information (default is 
Comma Separated) and Output 
File Name or location of the import 
job.

Select the columns you want 
included in the import file.
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Installing the PC Console Interface Unit 
Note: The Attendant PC software must be installed before the PC 
Console Interface Unit (PCCIU) is installed.

Required Hardware

• PC Console Interface Unit (PCCIU)

• one DB25 system cable

• one DB9 RS-232 serial cable that connects the “Installing the PC 
Console Interface Unit” on page 222 to the PC

• Adapter (may be required to connect the PCCIU to the PC with the DB9 
RS-232 serial cable)

• Handset

• Headset (optional)

Use Procedure 138 to install the PCCIU.

Procedure 138
Installing the PCCIU

1 Nortel recommends that you place the Attendant PC flat under the PC 
monitor with the front panel facing forward.

Figure 91
PC Console Interface Unit front panel

2 Connect one end of the DB25 system cable to the Meridian 1 connector 
on the rear of the Attendant PC.
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3 Connect the other end of the DB25 system cable to the MDF connector.

4 Attach the DB9 connector from the DB9 RS-232 serial cable to the PC 
port on the Attendant PC.

5 Connect the other end of the DB9 RS-232 serial cable to the serial port 
(COM port) on the PC.

Note: An adapter may be required to connect the DB9 RS-232 serial 
cable from the PCCIU to the PC.

Figure 92
PCCIU back panel
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6 Attach a headset to the RJ32 jack or a handset to the PJ327 two-prong 
connector jack on either side of the PCCIU. Ensure that the brandline 
plate on the handset connector jack faces forward. See Figure 93 for the 
correct PJ327 two-prong connector jack insertion.

Note 1: The PCCIU supports both amplified and non-amplified headsets.

Note 2: The PCCIU does not support carbon type headsets or handsets. 
Contact your Nortel distributor for further information on headsets and 
handsets.

Figure 93
Correct PJ327 insertion
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Figure 94
Incorrect PJ327 insertion

Figure 95
Connector usage
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7 If a Power Fail Transfer Unit (PFTU) is available, connect the Power Fail 
Transfer pair (11 and 36 in Figure 96 on page 227) from the MDF block to 
the PFTU.

8 If desired, install a M3900 Series Digital Telephone through the teledapt 
PHONE connector at the rear of the PCCIU using a two-wire pair on the 
MDF block (BACK_UP 1 and BACK_UP 2 in Figure 96 on page 227). 

Note 3: The M3900 Series Digital Telephone can be used as a Night DN, 
or if the PC fails.

9 Connect the General_Purpose relay to the MDF block as shown in 
Figure 96.

Note 4: LDN0 must be configured with EMER_DN for this relay to work 
properly.

10 Use the Audio Input/Output jacks to connect third-party audio 
applications, for example, a sound card. Refer to the third-party audio 
applications user manual for instructions.

End of Procedure
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Figure 96
 PCCIU system wiring to the MDF block

Use Procedure 139 on page 228 to configure the PCCIU.
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Procedure 139
Configuring the PC Console Interface Unit

1 Make sure that there are three available ports on the digital line card (or 
four free units if you installed an M3900 Series Digital Telephone in Step 
8 of Procedure 138 on page 222).

2 In LD 12, configure the first two ports as the primary and secondary TNs 
using the same setup as the M2250.

Refer toSoftware Input/Output: Administration (553-3001-311). At the 
TYPE prompt, enter 2250. 

Then configure the third unit as a power unit.

3 In LD 11, configure the fourth unit as a NIGHT_DN if you installed an 
M3900 Series Digital Telephone in Step 8 of Procedure 138 on 
page 222).

4 If you are using a PFTU, configure a TN in LD 10 using the same setup 
as the analog (500/2500-type) telephone. Refer to Software Input/Output: 
Administration (553-3001-311).

5 Place the PFT in the OFF position (1 = On, 0 = Off).

6 Ensure all system cross-connects to the PCCIU are wired at the MDF 
block. See Figure 96 on page 227.

7 Connect the DB25 system cable to the MDF block.

8 Connect the DB9 RS-232 serial cable to the PC serial port (COM port).

9 Launch the Attendant PC software application. 

Note: If you experience a one way speech path, check all 
cross-connections, and make sure all connections are secure.

End of Procedure

Self Test and Diagnostics

When the PCCIU powers up, it performs a self-test diagnostic routine. The 
Status LED on the front of the PCCIU should turn red for 2 seconds and then 
turn solid green, and the Diagnostics LEDs on the rear of the PCCIU should 
flash once and then turn off.

If a failure occurs during the PCCIU self-test diagnostic routine, the Status 
LED will change to yellow and the error will be indicated by which 
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Diagnostics LEDs are illuminated. Contact your authorized distributor to 
report the problem.

Note: Only one error can be indicated at a time, in priority-order from 
highest (1) to lowest (7).

Table 6
LED number, description, and priority PCCIU Status LEDs

Troubleshooting the Status LED

The Status LED indicates the current status of the PCCIU as follows:

• Solid green indicates that the PCCIU is operating normally.

• Off indicates that there is no power going to the PCCIU. Contact your 
system administrator.

• Flashing red is a major alarm indicating that a System-related error has 
occurred. Contact your system administrator to report the problem.

• Flashing green indicates one of the following:

a PCCIU is in Night Service or Position Busy

b Power Fail Transfer (PFT) switch is in the incorrect position 
(Off)

c handset or headset is not connected properly

LED#

1 2 3 4 Description    Priority

Off Off Off Off Self-test passed

On Off Off Off EEPROM failure 7

Off On Off Off Alerter micro failure 6

On On Off Off Port expander failure 5

Off Off On Off Loopback test failure 4

On On On Off RAM failure 1
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• Solid red indicates that the PCCIU is not communicating properly with 
the PC. Contact your system administrator to report the problem.

• Solid yellow indicates that a failure occurred during the PCCIU self-test 
diagnostic routine. Contact your Nortel authorized distributor to report 
the problem.

Stand-alone test procedure

Use Procedure 140 to perform the stand-alone test procedure.

Procedure 140
Performing the stand-alone test procedure

1 Disconnect the DB25 system cable to power down the PCCIU and then 
disconnect the DB9 RS-232 serial cable.

2 Make a connection between pins 2 and 3 on the PC port at the rear of the 
PCCIU. Nortel recommends you to use a DB9 connector with pins 2 and 
3 jumpered (shorted).

3 Power up the PCCIU by reconnecting the system cable and pressing the 
reset button at the rear of the unit.

4 Disconnect the DB25 system cable to power down the PCCIU, reconnect 
the DB9 RS-232 serial cable, and then reconnect the system cable.

5 If the PCCIU still fails to communicate with the PC, check the DB9 RS-232 
serial cable and the PC communication port settings.

End of Procedure

IMPORTANT!

The reset button should only be used when performing this stand-alone 
test procedure with pins 2 and 3 on the PC port connected (as 
described in step 2). The PCCIU runs its self-test diagnostics and goes 
into run mode. (If the PCCIU fails the self-test, the Status LED will turn 
yellow and the Diagnostics LEDs will indicate what is wrong, as 
previously described in “Self-Test and Diagnostics.”)
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Audio In/Out

The audio input/output jacks (3.5mm) are located on the rear panel. The input 
and output impedances are 600 Ω. These ports can be used to connect the 
PCCIU audio paths to external audio applications, under control of the PC 
application. 

Alarm or event notification

In the event of PC failure, or loss of synchronization/communication between 
the PC or PC-based Console application software and the PCCIU, there is no 
alarm or event indication. The PCCIU Status LED will still show solid green 
and calls will still present to the console.

To remove the console from service until the PC function is restored, activate 
the Power Fail Transfer (PFT) switch or remove the headset or handset. For 
further information, refer to the Meridian 1 PC Console Interface Unit Quick 
Reference Guide.
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Using Attendant PC Help Facility
The Attendant PC Help Facility gives you instant information about the 
console application. Whenever you press , you get information related to 
what you’re doing at that time; and then when you press  (cancel), you’re 
returned exactly to where you were before. 

And there’s more to help than that—there’s linking to related topics, a help 
index, information on keys and start up tips. It’s really a built-in manual that 
is always within easy reach by accessing the Help menu Contents tab using 
your mouse.

Figure 97 shows Attendant PC Help Facility window.

Figure 97
Attendant PC Help Facility 

F1

Esc

About the Nortel Meridian 1 
Attendant PC provides an 
overview of console features 
and describes how to register 
your software.

Features describes the 
Attendant PC’s ICI, TGB, 
flexible and virtual features.

Using the PC console screen 
details how to administer the 
console’s screen.

Configuring the PC console 
screen describes how to set 
up or manage console 
functions such as ICI,TGB, 
voice mail, and virtual features.

Reference provides quick 
access to glossary and 
troubleshooting information.
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Note: The Help facility is described in more detail in the section “Using 
the Attendant PC online help” on page 33.
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Installing the LAN Interface Software
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Overview
This section provides instructions for installing the Attendant PC LAN 
Interface software.

Requirements
Each workstation which will use the Attendant PC LAN Interface must 
already have the Attendant PC software installed and have met these 
requirements as described in CS 1000/Meridian PC Console Interface Unit 
Installation Guide (P0944090).

• PC compatible computer system containing:

— Pentium processor, 100 MHz or higher

— 16 MB RAM available memory

— Hard disk with at least 10 MB of free disk space



Page 236 of 270  Installing the LAN Interface Software

553-3001-320 Standard 4.00 July 2006

— 17” SVGA color monitor (set for 1024 by 768 resolution, 
256 colors)

— 16-bit sound board (recommended)

— Printer (optional)

— Network interface adapter

— Windows 95®, Windows 98®, Windows 2000®, 
Windows NT®, or Windows XP® operating systems

— RS232 serial port

Additionally, a workstation that will be part of the Attendant PC LAN 
requires the following:

• One copy of the LAN Interface software

• Connection to a Windows 95®, Windows 98®, Windows 2000®, 
Windows NT®, or Windows XP® compatible network

Installing the LAN Interface Software
Note: Before you set up the software, turn off any virus protection 
programs you may have running. Virus protection programs can interfere 
with the set up process.

The disk set in your package includes an InstallShield Wizard to help you 
quickly install your copy of the Attendant PC LAN Interface software.

Use Procedure 141 to install the LAN Interface software.

Procedure 141
Installing the LAN Interface software

1 Make sure that no applications are running.

2 Make a written note of the serial number printed on the disks. This number 
will be requested later during the installation.

3 Insert Disk 1 into the drive from which you want to install.

4 Double-click the My Computer icon on your Windows desktop.
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5 Double-click the Control Panel icon.

6 Double-click on Add/Remove Programs icon.

Figure 98 shows how to access the Control Panel and Add/Remove 
Programs.

Figure 98
Accessing the Control Panel 

Figure 99 on page 238 shows the Add/Remove Programs properties 
display window.
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Figure 99
Install/Uninstall property sheet from Add/Remove Programs properties 
page
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7 Click Install.

Figure 100 shows the Install Program from Floppy Disk window.

Figure 100
Install Program from Floppy Disk or CD-ROM window
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8 Click Next.

Figure 101 shows the Run Installation Program window.

Figure 101
Run Installation Program window

9 Click Finish. 

The Attendant PC LAN Interface setup prepares the “InstallShield 
Wizard” to assist you in the set up process.
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The installation process continues with the Attendant PC LAN Interface 
set up program or Welcome display. 

Figure 102 shows the Welcome window.

Figure 102
Welcome window
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10 Click Next to display the User Information window.

Figure 103 shows the User Information window.

11 Supply the appropriate information and click Next.

Figure 103
User Information window
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12 Click Next to choose the Destination Folder for the Attendant PC, or 
browse to select another folder.

Figure 104 shows the Choose Destination Folder window.

Figure 104
Choose Destination Location window
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13 Click Next to add icon programs to a Program Folder or type a new 
program folder.

Figure 105 shows the Select Program Folder window.

Figure 105
Select Program Folder window
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14 Click Next to accept the current settings. Click Back to change a setting.

Figure 106 shows the Start Copying Files window.

Figure 106
Start Copying Files window

A status gauge reports the final copying progress of the Attendant PC 
LAN Interface set up program.
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The Setup Complete window is displayed indicating that the Attendant 
PC LAN Interface software installation has been completed.

Figure 107 shows the Setup Complete window.

Figure 107
Setup complete display

15 Indicate a  to launch the program icons.

Figure 108 on page 247 shows the program icons.
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Figure 108
Attendant PC LAN Interface program icons

16 Click Finish to complete the Attendant PC LAN Interface installation.
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17 Enter the serial number found on the installation diskette, then click OK to 
confirm your serial number is correct.

Figure 109 shows the Attendant PC LAN Interface Serial number window. 

Figure 109
Attendant PC LAN InterfaceSerial number

Figure 110
PC LAN Interface software has been successfully installed

Installation of the LAN Interface software allows the sharing of directory 
information among workstations. When a workstation makes an entry in 
the directory, all workstations will be updated, including any information 
screens.

End of Procedure
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Configuring Access Privileges
Access privileges, which determine whether a given workstation can perform 
certain actions, such as make changes to the directory, are located under the 
Configuration menu “Attendants” tab.

The “Rights” box lists privileges that can be configured for each attendant. A 
check in a box indicates that the attendant has the privilege to perform the 
specified function.

For example, the attendant with the “New Attendant #1” identifier has the 
privileges to “Log on to a Console” and “Edit general parameters.” However, 
the absence of check marks in other boxes indicates that no other privileges 
are available to this attendant. This means that “New Attendant #1” could not, 
for instance, “Add/edit an attendant” or “Edit Directory Information.”

Note: You must register at least one Attendant PC and the LAN 
interface module before attempting to add additional workstations.

Figure 111 on page 250 shows the Meridian 1 Attendant PC Configurator 
window.
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Figure 111
Attendant rights
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List of terms
Alarm

Also called off-hook alarm security. Enables any call to be intercepted by a 
customer-defined extension; for example, by security’s extension. 

Auto Dial
A dialing feature available on a programmable feature key in which the 
telephone user programs the number into the Auto Dial key, which will 
thereafter dial the number whenever the user presses the key. 

Automatic Wake-up
A hospitality flexible feature which allows an overnight guest to state the time 
he/she wants to be awakened. The telephone system will ring the guest at the 
specified time.

Barge In
This flexible feature key enables you to verify the status (idle or busy) of any 
trunk or special service access line. 

Break In
A programmable feature key that enables you to enter an existing connection 
to offer a call or relay an important message (international use only).

Busy Verify
A flexible feature key that enables the attendant to verify the status (idle or 
busy) or any extension. 

Call Forward Busy
An ICI key that allows a call at a busy extension to be automatically routed 
to you because the extension was programmed this way.
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Call Forward No Answer
An ICI key that allows a call to an extension that does not answer to be 
automatically routed to you because it was programmed to do so.

Call Park
A flexible feature key that enables you to place a call on hold without 
occupying a loop key on your console.

Call Waiting
This light on the console indicates the number of calls in queue to be 
answered. If no calls are waiting, the light is off. If 1-3 calls are waiting, the 
light is green. If more than three calls are waiting, the light is red, and the 
number of calls waiting appears beside the light.

Calling Party Number
A programmable feature key that enables you to record the calling party 
number on an incoming collect call or to assign a special billing code to an 
incoming collect call.

Camp-on
Routes one additional external call to a busy DN. Applies only to 
attendant-extended calls. If the called party is not free within a specified time, 
the caller is routed back to the attendant as a recall.

Centralized Attendant Service (CAS)
One group of operators or attendants answers all telephone calls coming into 
a company’s Media Gateway 1000B (MG 1000B) within an assigned region. 
Enables the attendant at a remote location to automatically reroute calls to a 
CAS attendant at the main location. In addition, this feature enables the CAS 
attendant at the main location to get a dial tone from a remote location to 
extend a call there.

Charge Account
A flexible feature key that enables you to enter a charge account number for 
a call going out through your console.
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Codes
These codes permit you to temporarily override the access restrictions 
assigned to an on-site caller’s extension.

Communication Server for Enterprise 1000 (CSE 1000)
For CSE Release 2.0 (also known as “X21”), the term “CSE 1000” referred 
to an IP-based PBX. For Succession Release 3.0, the term “CSE 1000” was 
replaced by “Succession 1000”. For CS 1000 Release 4.0, the term 
“Succession 1000” was replaced by “Communication Server 1000S”.

Table 7 shows how this change has been implemented in product names.

Conference
Allows you to establish a conference with up to six parties (on two trunks), 
including yourself.

Console
A telephone receiver that can perform operations on incoming and outgoing 
calls, such as the large unit used by telephone attendants.

Controlled COS
Controlled Class of Service. A flexible feature key that enables the attendant 
to alter line restrictions for a group of users that all have the same Class of 
Service.

Table 7
Terminology changes: Communication Server for Enterprise (CSE)

Succession 3.0 CS 1000 Release 4.0

CSE 1000 Communication Server 1000S

CSE 2000 Communication Server 2000

CSE MX Multimedia Communication Server 
5100 (MCS 5100)
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Call Waiting Indication
One or more incoming calls are waiting to be answered; a key/lamp pair and 
a tone provide a warning. One waiting call can be answered when current call 
is released.

Destination
In telephony, the destination of a call is the called party.

DID trunks
Direct Inward Dial trunks; trunks on which outside calls are presented.

DID Route Control
A programmable feature key that enables you to direct calls coming in on 
DID trunks either to either to a set of extensions considered to be night 
destinations, or to normal extensions.

Display Calls Waiting
A flexible feature key that enables you to display the number of calls waiting 
to be answered at the console.

Display Destination
A programmable feature key that enables you to display the phone number of 
a called party.

Display Source
A programmable feature key that enables you to display stored numbers 
associated with Auto Dial, Speed Call, and Night Service.

Do-Not-Disturb Group
A programmable feature key that enables you to place a predefined group of 
extensions in the Do-Not-Disturb mode.

Do-Not-Disturb-Individual
A programmable feature key that enables you to place an individual extension 
or a predefined group of extensions in Do-Not-Disturb mode. 

DRC
See DID Route Control.
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DTMF
Dual-Tone Multi-Frequency. Tones generated when the keys on a telephone 
keypad are struck that enables the switch to signal the desired telephone that 
a caller wants to be connected.

Electronic Switched Network
See ESN.

Emergency transfer switch
This feature, accessible from your Attendant PC interface unit, will present 
incoming calls from selected trunks to preselected telephones instead of to 
your console. Use this feature only during an emergency when these 
telephones must have direct access to dedicated trunks.

End-to-End Signaling (EES)
This flexible feature that you program on the “Flex Keys” sheet from the 
Config menu, enables voice messaging (Voice Mail) and paging from the 
attendant.

ESN
Electronic Switched Network. A telephone system that uses electronics to 
perform call switching and associated billing.

Exclude Destination
An attendant presses the Excl Des button on the console so that he/she can 
have a private conversation with the calling party (source).

Exclude Source
An attendant presses the Excl Src button on the console so that he/she can 
have a private conversation with the called party (destination).

Fixed feature
A fixed feature appears in all installations of the Attendant PC and cannot be 
edited or removed. Fixed features include alarm, call waiting, CAS, 
conference, night service, position busy, release destination, release source, 
signal destination (source), and exclude destination (source).
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Flexible Feature
A console feature assigned in the System by an engineer and given a key label 
and definition in the console.

Foreign Exchange
See FX.

Fully Restricted
A call from a fully restricted extension. A person using this extension can 
place calls to and receive calls from other extensions and the attendant, but is 
denied access to all incoming and outgoing trunk lines. Incoming calls for a 
fully restricted extension come to the attendant, who then extends them.

FX
Foreign Exchange, type of trunk. Fx is the label on an ICI key which receives 
calls from Foreign Exchange trunks.

ICI
Incoming Call Indicator. A key on the Attendant PC interface unit that flashes 
to inform the attendant that an incoming call on a particular trunk is waiting 
to be answered. An ICI “key” indicates the first call; later calls light up the 
message waiting indication until the first call is released.

May also refer to the light that identifies the type of call coming to your 
console (ICI), such as internal external, WATS, tie trunk, emergency, and so 
on. All incoming calls are queued automatically in the order of arrival, and 
the appropriate ICI indicators go on. You can click on a flashing ICI light to 
answer the call associated with it. Set up your ICI keys from the ICI keys page 
on the Config Console menu.

Incoming Call Indicator
See ICI.

Intercept
The call that activates this button may be from a caller who dialed the access 
code for a busy trunk group, or from a caller encountering equipment or 
dialing irregularities, such as a caller who dialed an extension in Do-Not- 
Disturb mode. Finally, this call may be from a restricted or semi-restricted 
extension attempting to make a call that is not allowed.
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Interpositional Call
Interpositional Call. This ICI key indicates an incoming call from another 
attendant at your location.

LDN
Listed Directory Number. This is an ICI key that indicates a call to a number 
for your organization that is found in the public telephone directory. When the 
feature Network Attendant Services is enabled, the LDNs are recognized 
across the network.

Listed Directory Number
See LDN.

Loop
A line that comes into the console, over which the attendant can assign an 
outgoing call or answer an incoming call.

Malicious Call Trace
A flexible feature key that enables you to identify an internal obscene or 
otherwise objectionable call. This feature can also trace static on the line.

Meridian
The term “Meridian” represents a Nortel product family. For CS 1000 
Release 4.0, the term “Meridian” has been removed from several product 
names. Table 8 shows how this change has been implemented. 

Table 8
Terminology changes: Meridian

Succession 3.0 CS 1000 Release 4.0

Meridian Integrated Call Assistant 
(MICA)

Integrated Call Assistant

Meridian Integrated Conference 
Bridge (MICB)

Integrated Conference Bridge

Meridian Integrated Personal Call 
Director (MIPCD)

Integrated Call Director
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Message Cancellation
A flexible feature key that enables you to turn off the message waiting signal 
at an extension after you have delivered the message for that extension.

Message Center
This ICI key indicates that a caller wants to leave or retrieve a message. This 
indicator appears only on Attendant PCs programmed to handle message 
center features.

Message Indication
A flexible feature key that enables you to turn on the message waiting signal 
at an extension for which a message has been taken.

NAS
Network Attendant Services. This feature allows attendant console positions 
to be dispersed in multiple locations within the network. Pressing the NAS 
key on your console makes you available for calls from all network locations. 

Night (Service)
The System goes into night service when all consoles are unattended. Then, 
all incoming calls are routed to a destination other than the consoles (such as 
to a security representative), or to a Night Service Extension (where callers 
may hear a recorded message).

Paging
A programmable feature key that enables you to connect to your 
organization’s paging equipment. Press the key for the duration of your 
announcement.

Meridian Integrated Recorded 
Announcement (MIRAN)

Integrated Recorded Announcer

Meridian Integrated Voice Service 
(MIVS)

Hospitality Integrated Voice 
Services

Table 8
Terminology changes: Meridian

Succession 3.0 CS 1000 Release 4.0
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Peripheral Equipment (PE)
On CS 1000 systems, Intelligent Peripheral Equipment (IPE) is supported, 
but Peripheral Equipment (PE) is not supported.

Position busy
When an attendant will be leaving the console, he/she presses this button. As 
a result, the System transfers all calls incoming to the departing attendant’s 
console to other attendants. 

Recall
This ICI key indicates the return to you of a call that you have put through to 
an extension that is busy or does not answer within a set time (usually 30 
seconds). This ICI can also indicate a call from an extension user who has 
activated the Attendant Recall feature. 

Release
Mouse-operated key on the right side of the Attendant PC Software screen 
display. Enables the attendant to release a connection from the console.

Release destination
A Fixed Feature key on the console which allows the attendant to disconnect 
the called party (destination) from a call. 

Release Line Trunk
Telecommunications line used with Centralized Attendant Service to connect 
callers from a remote location desiring an attendant at a main location.

Release source
A Fixed Feature key on the console which allows the attendant to disconnect 
the calling party (source) from a call.

Remote
A key on systems equipped for CAS (Centralized Attendant Service) that 
indicates a call from a remote location, routed over a release link trunk.
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Restricted “0”
Key turns on when a call is from a fully restricted extensions, which is denied 
access to all incoming and outgoing trunk lines. Incoming calls for a fully 
restricted extension come to the attendant, who can then extend them.

RLT
See Release Line Trunk.

Route access codes
Directs a call over a certain route to reach a specific destination. The code 
may represent a specific line for a call (Tie, WATS, or public trunk) or an 
attendant console for placing or transferring a call. 

Signal destination
The attendant pushes a key that signals a called party that he/she is connected 
to the attendant.

Signal source
The attendant pushes a key that signals a caller that he/she is connected to the 
attendant.

Source
In telephony, the source of a call is the calling party.

Speed Call
A dialing feature available on a programmable feature key that enables you 
to dial any number stored by the Speed Call Controller. As an alternative you 
can enter the Speed Call SPRE code, and then enter the code assigned to the 
desired number. 

Speed Call codes
A feature available on a programmable feature key that uses a code to dial a 
programmed number automatically. The Speed Call Controller assigns codes 
to the list of telephone numbers for dialing by the Speed Call feature key.
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SPRE codes
Special PREfix code, one to four digits long, that is assigned by your System 
administrator. You use the code to operate a feature for which your console 
has no dedicated (programmed) feature key. 

Stored number redial
Pressing the correct flexible feature key allows a number to be stored after it 
has been dialed, either before or during the connection, for later automatic 
dialing.

Succession
The term “Succession” represents a Nortel product family. Within this 
family, the term “Succession 1000” represents the name of an IP-based PBX, 
while “Succession Call Server” represents the name of a component. 

For CS 1000 Release 4.0, the family name “Succession” has been replaced by 
“CS 1000”, while the product name “Succession 1000” has been replaced by 
“CS 1000S”. 

In addition, the term “Succession” has been removed from the name of 
several components in CS 1000 systems (CS 1000E, CS 1000M, and 
CS 1000S). 

Table 9 shows how this change has been implemented in product names. 

Table 9
Terminology changes: Succession (Part 1 of 2)

Succession 3.0 CS 1000 Release 4.0

Succession 1000 Communication Server 1000S

Succession 2000 Communication Server 2000

Succession Branch Office Media Gateway 1000B

Succession Call Server Call Server

Succession Element Manager Element Manager

Succession Media Card Media Card
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Supervisory mode
Selecting the Make Set Busy key when your set is idle enables you to monitor 
other attendants, call an attendant, transfer a call to another attendant, and 
receive a call from another attendant.

System Speed Call Controller
A flexible feature key that can overcome restrictions on individual telephones 
via programming so that the users can call out to s specific set of numbers, 
such as for emergencies (ambulance, fire department, 911) or to a company 
out-of-area MG 1000B, etc.

Through-dialing
Extension or tie-line users may request access to a number which requires use 
of a trunk which they are not allowed to access. Access the trunk for the user. 
Then the user can then dial out (except onto fully restricted trunks).

Tie trunk
A dedicated circuit linking two PBX’s.

Trunk group
A set of telephone lines of a particular type, such as WATS, TIE, public, or 
Foreign exchange.

Trunk group busy (TGB) keys
Your console may have up to ten trunk groups, but only if ICI2 is provisioned 
on the System. Press a Trunk Group Busy key to deny users access to that 
trunk group. Configure TGB keys from the TGB page from the Console 
Config choice on the Config menu.

Succession Signaling Server Signaling Server

Succession System Controller Small System Controller

Table 9
Terminology changes: Succession (Part 2 of 2)

Succession 3.0 CS 1000 Release 4.0
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Trunk-to-trunk call
A user, while outside the system, may call to request access to an outgoing 
trunk. You dial the trunk access code, than the requested number. Press RLS 
to connect the calling and called parties.

Unanswered wake-up calls
If a hotel/motel guest does not respond to the first wake-up call, the System 
makes up to two more attempts at 5-minute intervals. If the guest does not 
answer after the third call, the System, if set for this option, notifies you of an 
unanswered wake-up call.

Unrestricted or Semi-restricted
Refers to a call from an unrestricted or semi-restricted extension. An 
unrestricted extension user can place and receive all types of calls. A 
semi-restricted extension user can place calls to other extensions, and can 
place calls to the public network with the assistance of the attendant.

VIP wake-up
A hospitality feature that extends a VIP wake-up call to your console. Press 
an idle loop key, followed by the Auto Wake-up key. If the DN is busy or the 
guest does not answer, press the RLS key. If the guest answers, deliver a 
personal wake-up message to the guest.

Virtual feature
A console feature created entirely using software commands. 

WATS
Wide Area Telecommunications Service. A discounted long-distance service 
provided by all telephone companies. Also, a label on one or more of your 
Loop Pickup keys.

To refer to the hardware platform that supports a Branch Office 
configuration, the term Media Gateway 1000B (MG 1000B) is used.
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Index

A
adapter, 222

adding a flexible feature, 84

adding an ICI key, 47, 49, 90, 92, 94

Alerter page
Attendant PC Properties sheet, 96

answering a call, 106

Answer key, 31

attendant
break-in, busy indication, 136

Attendant Console Autoline, 129

Attendant Emergency Codes, 130

Attendant monitoring
a trunk, 138

Attendant PC Properties sheet
Alerter page, 96
Call Waiting page, 97
Diagnostics page, 100
Handset page, 98
options (pages, tabs), 96
Relay page (diagram), 99

Attendant PC unit, 222

Attendant Recall, 113

Audio Input/Output jacks, 226, 231

authorization code (ESN), 178

Auto Dial, 139

Auto Dial number
storing, 140

Autoline, 129

Automatic Wake Up, 140

B
barge-in, 144

break-in
by attendant to busy extension, 136

build the operator Toolbox, 51

busy verify, 145

C
call

answer from a remote console (NAS), 175
extending a call to an idle extension (CAS), 

170
extending to busy remote ext. (NAS), 176
extending to busy remote loc. (CAS), 171
extending to idle remote ext. (NAS), 176
extending with off-hook queueing (ESN), 181
putting on silent hold (CAS), 172
transfer to another remote ext. (NAS), 178

Calling
an Auto Dial number, 139
an extension, 116
another attendant, 119
an outside number, 116

Call Park, 110, 212
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Call Waiting page (Attendant PC Properties sheet), 
97

Camp-on, 107

cancelling Do-Not-Disturb, 149

CAS features
extending a call to an idle extension, 170
Extending call to a busy remote ext., 171
putting a call on silent hold, 172
remote recall, 173
transferring recall to remote extension, 174

Centralized Attendant Service features, 169

Centrex Switchhook Flash, 127

change database location, 217

Change Password dialog box, 102

Charge Account, 145

Charge account (ESN), 179

Conference, 118

conference call, 118

Config menu
submenu list, 77

Console Config sheet
Features page, 83
ICI’s page (diagram), 47, 49, 92, 94

console keys, using, 31

Contents tab, 185

CPLUS
accessing a CPLUS directory, 214

Create a Directory entry, 57

creating an information screen, 73

creating hotkeys, 79

creating virtual features, 41, 85

customizing keys, 41, 85

D
database, 217

diagnostics, 228, 230

Diagnostics LEDs, 228

Diagnostics page (Attendant PC Properties sheet), 
100

dialing, 28, 33

dialog boxes
Change Password, 102

DID Route Conversion, 146

DID routes
controlling, 146

digital line card, 228

directory, 217

Directory command on Tools menu, 56

displaying, changing Night Service option no., 157

Do-Not-Disturb
cancelling, 149
overriding, 150
testing, 150

E
End-to-end signaling feature, 151

Enhanced Night Service, 152

enhanced night service
turning on and off, 153

Enhanced Secrecy feature, 154

ESN
authorization code, 178
Charge account, 179
expensive route warning tone, 180
routing control, 182

Exit option, 38

expensive route warning tone (ESN), 180

exporting Directory numbers, 219

Extending a call, 107
off-hook queueing (ESN), 181
to a busy extension (with Camp-on), 107
to a busy extension (with Hold), 108
to idle remote ext. (NAS), 176
to voice mail, 108
to voicemail, 108
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extending a call
to a busy remote extension, 171

F
Feature List option, 38

features commonly available, 83

Features page, 83

Flex Keys page (Console Config sheet), 89

G
General page (Console Config sheet), 78

General Purpose relay, 226

H
handset, 222

Handset page (Attendant PC Properties sheet), 98

hardware, 222

Help menu, 33, 184
choices, 33
Console Help, 33
Contents selection, 33
Contents tab, 185
Context Help selection, 33
Find tab, 187
Glossary, 189
Index selection, 33
Index tab, 186
Options menu, 188

help topics, 233

holding a call on a lpk key, 109

Hold key, 31

hotkeys, 80

I
IADN, 130

ICI keys, how to set up, 90

ICI List option, 38

importing Directory dialing numbers, 220

Incoming Call Indicator keys, 46

Index tab, 186

Individual Attendant Directory Number, 130

information screens
accessing, 74
creating, 73

installation
Attendant PC software, 193

K
key operation, 31

L
license agreement, 198

loop keys, 31

M
Main Distribution Frame (MDF), 222

main screen, 209

major alarm, 229

menus
Help, 33
Tools, 38

Meridian Digital Telephone, 226

monitoring by attendant
trunk, 138

N
NAS (Network Attendant Service)

answering a call from a remote console, 175
extending a call to a busy remote ext, 176
extending a call to idle remote ext. (NAS), 176
features, 174
remote recall, 177
transferring a call to another remote ext., 178

network features
Centralized Attendant Service (CAS), 169
ESN, ISDN, 169
Network Attendant Service (NAS), 169
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network speed call (ESN), 181

Night Service, 156
displaying, changing option number, 157
enhanced, 153
enhanced feature, 152
turning on and off, 156

O
online help, 183, 233

overriding Do-Not-Disturb, 150

P
Paging feature, 158

PJ327 2-prong connector jack, 224

ports, 228

Position Busy feature, 159

power
no power going to the Attendant PC unit, 229

Power Fail Transfer Unit (PFTU), 226, 228

Procedures
Adding a flexible feature, 84
Adding an ICI key, 47, 49, 92, 94
Create a Directory Entry, 57
Setting up the Voice Mail icon, 79

putting a call
on hold, 109
on silent hold, 172

R
recall

remote (CAS), 173
remote (NAS), 177
transf. to another remote ext., 174

Recalls
from an extension using Conference key, 114
from an extension using LINK or ATT 

RECALL, 113
from an extension using Transfer key, 114
from an unanswered extended call, 111, 112

redialing a stored number, 166

registration, 210

Relay page (Attendant PC Properties sheet), 99

Release key, 31

RJ32 jack, 224

routing control (ESN), 182

RS232 cable, 222

S
self test, 228, 230

serial number, 208

setting up
console Directory, 56
flexible features, 89
ICI keys, 47, 48, 49, 90, 92, 94
TGB keys, 94
Voice Mail icon, 79

setup type, 201

shortcut
creating a shortcut, 207

software installation, 193

speaking privately feature, 163

Speed Call Number
network (ESN), 181

splitting feature, 163

Standard, 3

Status LED, 228

stored number redial
redialing, 166
storing ahead of time, 167

storing
an Auto Dial number, 140
a stored number ahead, 167

Supplementary features
Break-in (busy verify), 124
Break-in (pre-dial), 122

system cable, 222



Index  Page 269 of 270

Attendant PC Description, Installation, and Operation

system requirements, 192

System Speed Call, 168

T
telephone, 226

testing Do-Not-Disturb, 150

TGB’s page (diagram), 94

TGB keys, 49

TGB List option, 38

through-dialing, 117

Timed recall
from an unanswered extended call, 111
from an unanswered parked call, 112

Toolbox, 216

Toolbox command on Tools menu, 51

Toolbox option, 38

Tools menu, 38

Tools option, 38

tracing a malicious call, 155

Transferring a call
to another attendant, 120
to remote ext. (NAS), 178

Transferring a recall
to another extension, 114
to remote ext. (CAS), 174

troubleshooting, 229

Trunk Group Busy keys, 49

trunk group busy keys, status, 32

trunk-to-trunk call, 117

turning enhanced night service on and off, 153

turning night service on and off, 156

V
virtual feature keys, 85

voice mail, 108, 211



Page 270 of 270 Index 

553-3001-320 Standard 4.00 July 2006





Family Product Manual Contacts Copyright FCC notice Trademarks Document 
number Product release Document release Date Publish

Nortel Communication Server 1000

Attendant PC
Description, Installation, and Operation

Copyright © 2006 Nortel Networks.All rights reserved.

The information in this document is subject to change without 
notice. The statements, configurations, technical data, and 
recommendations in this document are believed to be accurate 
and reliable, but are presented without express or implied 
warranty. Users must take full responsibility for their 
applications of any products specified in this document. The 
information in this document is proprietary to Nortel Networks.

Nortel, Nortel (Logo), the Globemark, SL-1, Meridian 1, and 
Succession are trademarks of Nortel Networks.

Publication number: 553-3001-320
Document release: Standard 4.00
Date: July 2006
Produced in Canada

To provide feedback or report a problem with this document, go 
to www.nortel.com/documentfeedback.


	Title page
	Revision history
	Contents
	List of procedures
	About this document
	Subject
	Applicable systems
	Intended audience
	Conventions
	Related information
	How to get Help
	Getting Help from the Nortel Web site
	Getting Help over the phone from a Nortel Solutions Center
	Getting Help through a Nortel distributor or reseller


	Overview
	Contents
	Description
	About the Attendant PC
	Starting the Attendant PC
	Menus
	Two-line display
	Position Busy indicator
	Fixed keys
	Loop keys
	Incoming Call Indicator Keys
	Trunk Group Busy keys

	Placing a call
	Using the Attendant PC online help
	Using the Help Index feature
	Exploring the Help Console


	Working with the Tools menu
	Contents
	Tools menu
	Feature List
	Fixed features
	Flexible features
	Virtual features

	ICI List
	Adding an ICI key
	Using the ICI Keys page

	TGB keys
	Building a ToolBox
	Accessing the CPLUS Directory
	Directory
	Starting the Directory
	Creating a Directory entry
	Editing a directory entry
	Deleting a directory entry
	Exporting Directory dialing numbers
	Importing Directory dialing numbers
	Changing a directory number (DN)
	Searching the directory
	Using information screens

	Logging off the Attendant PC

	Working with the Config menu
	Contents
	Description
	Configuration menu
	Console Configuration
	Interface properties
	Configure Port
	Change Password


	Attendant PC call processing
	Contents
	Answering a call
	Extending a call to an idle extension
	Extending a call to a busy extension (with Camp-on)
	Extending a call to voice mail
	Extending a call to a busy extension (with Hold)
	Holding a call on a loop key
	Call Park
	Timed recall from an unanswered extended call
	Timed recall from an unanswered parked call
	Recall from an extension using LINK or ATT RECALL
	Recall from an extension using Transfer
	Recall from an extension using Conference
	Recall to Same Attendant
	Calling an extension
	Calling an outside number
	Trunk-to-trunk call
	Through-dialing
	Conference
	Calling another attendant
	Transferring a call to another attendant
	Break-in (post-dial)
	Break-in (pre-dial)
	Break-in (busy verify)
	Sending a warning tone to an extension in line lockout
	Requeueing a call to the next available attendant
	Timed Reminder Recall
	Centrex/Exchange Line Switchhook Flash
	Remote Call Forward
	Call Forward/Hunt Override
	Attendant Console Autoline
	Individual Attendant Directory Number (IADN)
	Attendant Emergency Codes
	Recovery on Misoperation of Attendant Console

	Attendant PC features
	Contents
	Features
	Attendant Blocking of Directory Number
	Attendant Break-in Busy indication and prevention
	Attendant Monitor
	Auto Dial
	Automatic Wake Up
	Barge-in
	Busy verify
	Charge Account
	DID Route Conversion
	Do-Not-Disturb
	End-to-end signaling
	Enhanced Night Service
	Enhanced Secrecy
	Malicious Call Trace
	Night Service
	Paging
	Position Busy
	Radio Paging
	Semi-automatic Camp On
	Series Call
	Speaking privately (Splitting)
	Speed Call
	Stored Number Redial
	System Speed Call


	Attendant PC network features
	Contents
	Features
	Centralized Attendant Service
	Network Attendant Service
	Networking (ESN, ISDN) features


	Using the Attendant PC Help Facility
	Contents
	Description
	About the Help facility
	The Help menu
	Console Help F1
	Options menu
	Glossary descriptions of console features
	About the Attendant PC software


	Installing the Attendant PC Software
	Contents
	Overview
	System requirements
	Installing the software
	Registering the Attendant PC software
	Configuring voicemail
	Programming a Call Park Virtual Feature
	Accessing the CPLUS Directory
	Changing database location
	Exporting Directory numbers
	Importing Directory dialing numbers
	Installing the PC Console Interface Unit
	Required Hardware
	Self Test and Diagnostics
	Troubleshooting the Status LED
	Stand-alone test procedure
	Audio In/Out
	Alarm or event notification


	Using Attendant PC Help Facility
	Installing the LAN Interface Software
	Contents
	Overview
	Requirements
	Installing the LAN Interface Software
	Configuring Access Privileges

	List of terms
	Index

